The Plant Water Management Experiments

Marc Benjamin Wasserman
Portland State University

Follow this and additional works at: https://pdxscholar.library.pdx.edu/open_access_etds

Part of the Physical Sciences and Mathematics Commons

Let us know how access to this document benefits you.

Recommended Citation
https://doi.org/10.15760/etd.7948

This Thesis is brought to you for free and open access. It has been accepted for inclusion in Dissertations and Theses by an authorized administrator of PDXScholar. Please contact us if we can make this document more accessible: pdxscholar@pdx.edu.
The Plant Water Management Experiments

by

Marc Benjamin Wasserman

A thesis submitted in partial fulfillment of the requirements for the degree of

Master of Science
in
Mechanical Engineering

Thesis Committee:
Raúl Bayoán Cal, Chair
Gerald Recktenwald
Derek Tretheway
Mark Weislogel

Portland State University
2022
Abstract

A simple means of watering plants in the low-g environment aboard orbiting spacecraft is not obvious. Since the beginning of spaceflight, numerous approaches have been pursued to water plants that seek to maximize plant viability and system reliability, while minimizing crew time and system complexity. The Plant Water Management experiments (PWM) seek to apply recent advances in low-gravity capillary fluidics to the challenges faced during plant growth operations aboard spacecraft. One primary challenge encountered in such applications is to establish Earth-like flows, minimizing the low-g specific adaptations required by the plants. This is difficult due to the fluid physics challenges associated with poorly-wetting multi-phase inertial-visco-capillary flows in geometrically complex conduits and containers which change dramatically throughout the life cycle of the plants. In this thesis, preliminary results for two recent experiments from the Plant Water Management series of experiments are presented and discussed.

The first portion of this thesis presents results from six days of 24-7 experiments testing 3 different plant root model geometries in a soil-based test cell aboard the International Space Station. Within each test cell, porous clay ‘soil reservoirs’ are arranged within a non-wetting host soil that serves the purposes of root oxygenation and as a wetting barrier to control fluid distribution within the soil. The experiment also demonstrates passive watering via a fluid reservoir with a capillary connection to the soil test cell. Despite wide variations in model plant resistances intended to demonstrate a ‘falling’ water table effect, all models converged towards similar,
evaporation-rate limited performance. This behavior is explored and explained via a capillary flow model developed to capture the primary features of the flows.

The second portion of this thesis presents a selected set of preliminary results from six days of experiments with open hydroponic capillary channels and synthetic plant models. Tests performed during nearly 40 hours of flight operations include demonstrations of flow stability in single, parallel, and serial channel arrangements. Stability is explored across a range of flow rates, plant model types, and plant arrangements. Technology demonstrations of both passive aeration and gas-liquid phase separation are also explored. The hydroponics experiment presented here includes more than 430 individual test runs, the bulk of which have not yet been explored. To aid in future analyses, a catalog of experimental runs and associated metadata is created and provided. This catalog substantially reduces the barriers to accessing relevant experimental data and represents one of the primary contributions of this work. Data reduction processes and the methodology used to create the catalog are discussed.
Acknowledgements

I would like to express my deep gratitude for my advisor, Mark Weislogel, for his wisdom and guidance throughout the project. I would also like to thank Jesse Goodman for his camaraderie and instruction in drop tower use, Karl Kardin for assistance with scripting, Rihanna Mungin for her wealth of PWM knowledge and development of the plant root models, and Logan Torres for his assistance during many nights of flight operations. My sincere thanks also go out to Raúl Cal for agreeing to step into the role of advisor during the later portion of my program. Finally, I would like to thank Amelia Wasserman for her support and patience throughout this journey.

Financial support for this work has been provided in part through NASA Cooperative Agreement 80NSSC18K0436.
Table of Contents

Abstract i

Acknowledgements iii

List of Tables vii

List of Figures viii

List of Symbols xvi

List of Abbreviations xviii

Chapter 1 Bioregenerative Life Support Systems 1

1.1 Concept of Operations ........................................... 1

1.2 Water Management Challenges in Microgravity .................. 2

1.3 Overview of Plant Growth Systems .......................... 2

Chapter 2 The Plant Water Management Experiments: Soil 6

2.1 Introduction ..................................................... 6

2.2 Experiment Hardware and Procedures .......................... 6

2.3 Summary of Primary Results .................................... 12
2.4 Operational Notes and Lessons Learned ........................................ 17
2.5 System Flow Resistance and Modeling Foliage Flow .................... 24
2.6 Conclusion ................................................................. 31

Chapter 3 The Plant Water Management Experiments: Hydroponics

3 & 4 .......................................................... 33
3.1 Introduction and Theory .......................................................... 33
3.2 Experimental Overview .......................................................... 36
3.3 Primary Preliminary Results ....................................................... 45
3.4 Conclusions ................................................................. 61

Chapter 4 Conclusions, Recommendations, & Outlook ........................................ 64

Bibliography ................................................................. 67

Appendix A Data Reduction for Soil Operations (PWM 1) ....................... 70
A.1 Image Corrections with Irfanview ................................................ 70
A.2 Meniscus Tracking in FIJI/ImageJ ................................................... 73
A.3 Contact Angle Determination ....................................................... 77

Appendix B Data Reduction for PWM-Hydroponics Operations ............... 79
B.1 Preliminary Video Handling & Clips Archive .................................... 79
B.2 Pump-Head Speed Check Procedure (FFT) .................................... 82
B.3 Automated Volume Tracking Process ............................................ 86

Appendix C Data Reduction Scripts ................................................. 94
C.1 ImageJ/FIJI Pump Speed Script .................................................... 94
C.2 Matlab FFT Script .................................................. 96
C.3 ImageJ Volume Analysis Script ................................. 98
C.4 Matlab Volume Analysis Scripts ................................. 101

Appendix D Clips Archive Spreadsheet for Plant Water Management

3 & 4 .............................................................................. 105
List of Tables

Table 2.1  PWM Soil Operations table. Investigator team participated live during all priming and stow operations. Other activities were completed based on predetermined crew procedures.  

Table 2.2  Characteristic viscous resistances for plumbing elements of model sketched in Figure 2.11c. Total \( \sum_{j=1}^{11} (L/Ar_p^2)_{j} \) values \( \cdot 10^{-3} \text{cm}^{-3} \) are 26,063 (Slow), 8,263 (Med.) and 6,563 (Fast). The porosities of arcillite soil and Rayon felt are \( \epsilon_{\text{soil}} \approx 0.26 - 0.47 \) and \( \epsilon_{\text{felt}} \approx 0.95 \). The active foliage area (faces and sides) is \( \approx 305 \text{ cm}^2 \).  

Table 3.1  Summary of PWM-Hydroponics operations for Wedge (W) and Cylinder (C) channels with a brief description of demonstrations performed. All dates are 2021.  

Table 3.2  Overview of demonstrated operations, flow patterns and bubble diverters. Clips references to PWM 3 & 4 archive for these flows are indicated in the right-most column. The total experiment times (hh:mm) for the Wedge and Cylinder channels are 22:05 and 17:03, respectively.
List of Figures

Figure 1.1  a. Packed Nomex and Kevlar “plant pillows” prepared for shipment to the ISS for use in the VEGGIE habitat (image credit: NASA). The seed germination wicks can be seen as the white squares on top of the black pouches, while the cylindrical protrusions are the priming ports. b. Astronaut Shannon Walker harvests kale plants grown in one of the two active VEGGIE habitats aboard ISS (image credit: NASA).  

Figure 1.2  Flowering and fruiting pepper plants growing in the Advanced Plant Habitat in November, 2021 (image credit: NASA). Note the mesh fabric covering the growing media in the lower portion of the chamber.

Figure 2.1  a. Soil Test Cell (scale in cm) and b. PWM-Soil Medium hardware during operations on ISS. The darker arcillite soil is wetted by the grape beverage ersatz liquid and only the base of the foliage is wetted. Reservoir meniscus height location $h(t)$ is identified in b.
Figure 2.2  a.-d. Low-g ‘falling water table’ concept - as foliage and roots grow, the soil saturation level drops drawing additional air into the soil with priming feed wick shown in red. e.-h. Simple control wick method chosen for PWM-Soil models to vary root delivery rate for f. Slow, g. Medium, and h. Fast models. Dimensions in cm.

Figure 2.3  Cropped images of the PWM-Soil Medium Test Cell during prime and capillary infill showing reservoir bridging. The 2nd Soil Reservoir is wetted at 30 min and nearly saturated by 35 min.

Figure 2.4  Cropped and processed images of the Medium Test Cell Foliage with times in minutes recorded 50 minutes after liquid is first introduced into the test cell and 15 minutes after the crew first reported observing fluid in the foliage.

Figure 2.5  Liquid volume uptake into PWM-Soil test cells as determined by fluid depth in reservoir \( h(t) \). The Fast run included two reservoir refills while Medium and Slow runs were not refilled.

Figure 2.6  Transient flow rates derived from power-law fit functions of data in 2.5. Note that Fast, Medium and Slow test cells were force filled to 25.5, 16.0, and 8.2 mL, respectively.

Figure 2.7  Image of Foliage at the conclusion of PWM-Soil Fast test cell run. The glistening surface reveals dye and sugar gradients due to water evaporation from the Tropical Fruit Punch beverage.
Figure 2.8    a. ‘Lightly’ compressed engineering sample after terrestrial vibration test and ‘moderately’ compressed soils seen during fluid prime for b. Slow, c. Medium, and d. Fast Soil Test Cells. Wedge and 1st reservoirs are distorted to the point of capillary contact in flight test cells, but 1st and 2nd soil reservoirs remain unconnected for Slow and Fast Test Cells. Capillary connection between 1st and 2nd soil reservoirs identified in c.  

Figure 2.9    Illustration of the ‘stick-slip’ behavior observed in the reservoir ($d = 3.5$ cm) during the Fast run, with run time (hh:mm) superimposed on the images. From left to right, the first two images show the meniscus receding towards the outlet at the bottom of the reservoir while the contact line remains stationary. In the third image, the contact line has slipped downwards, as indicated by the black arrow. In the right-most image the meniscus once again moves downward, as indicated by the white arrow, while the contact line remains stationary, starting the ‘stick-slip’ cycle over again. 

Figure 2.10    Meniscus ‘sidling’ behavior observed during the Fast run. As time progresses in the images from left to right, the contact line can be seen to move downwards in an asymmetric fashion, with the right side dropping more quickly than the left. In the right-most image, the contact line returns to a nearly perpendicular orientation.
Figure 2.11  a. Annotated schematic of PWM Soil test unit (dimensions in cm) with b. fluid element model and c. simplified mathematical model. $H$ is depth into the page.

Figure 2.12  Visco-capillary flow model for flow along a stack of disc-sectors: a. Single disc-sector showing advancing meniscus $l(t)$ and b. Stacked lay-up of single disc-sector flows modeling a porous network with evaporation volume loss $\dot{E}$ through the top and bottom surfaces.

Figure 3.1  Open wedge channel capillary flow with a. free ($L$), b. pinned ($L_p$), and partially pinned contact line boundary conditions. Flow is introduced at left, removed are right, capillary driven flow in between driven by cross flow free surface curvature gradient.

Figure 3.2  a. Solid model of PWM-Hydroponics hardware with b. image during flight operations ($Q = 0$-4.9 mL/s, parallel wedge channel flow, 2-each felt tap root models, clip refs. 59-63). The wye fittings are swappable for 3D printed gas/liquid phase separators and the test channels are swappable between Wedge and Cylinder styles. Plant models are readily added and removed. Upstream tubing is out of frame left in b.

Figure 3.3  Open a. Wedge (76 mL) and b. Cylinder (79 mL) channels with sectional views employed by PWM-Hydroponics 3 & 4 on ISS. Approximate volumes to pinning edges provided. Inlets are sized for 1/4 in Luer Lock fittings with 3/16 in ID tubing. All dimensions in mm. Active channel length is 150 mm.
Figure 3.4  Scaled images of the six plant models: a. Simulated Plant Kit with b. small (4ea), c. medium (4ea), and d. large synthetic weave (4ea), e. braided nylon (6ea), f. small (4ea), and g. large felt tap root (2ea). Dimensions in mm.

Figure 3.5  Illustration of image data reduction process to determine pump flow rate: (left to right) still frame image of pump head, z-profile plot of pump head pixel intensity, and an FFT with the pump-head frequency highlighted.

Figure 3.6  Sequential/iterative images of pulsed priming for Wedge (a.-e., GMT 89, clip ref. 3) and Cylinder (f.-j., GMT 90, clip ref. 142) channels. Black arrow in a. identifies pinning edge, white arrows identify fill/drain location and direction.

Figure 3.7  a. Approximately 23 min single Wedge channel flow for a ramp sweep in flow rate. Volume measurements are constant at 55.6 ± 0.4 mL apart from crew-induced disturbances during the run (indicated by grey boxes). b. Four free surface overlays on a representative (scaled) image of flow in a. demonstrating surface stability through the range of pump flow rates listed.

Figure 3.8  Variety of stable free surface configurations in Wedge channel at flow rates 1.64-1.85 mL/s. a. No plants (clip ref. 40), b.-c. nylon root plants (clip refs. 229, 234), d.-f. taproots (clip refs. 40, 65, 46), and g.-i. weave roots (clip refs. 81, 87, 126). Recirculation zones identified. Note local de-pinning in g. and h. where roots contact the wall of the container.
Figure 3.9  Select demonstrations of typical hydroponics activities (Wedge channel): a.-c. channel refill after new plant placement, d.-f. passive bubble separation (white arrow) in inlet region during steady bubbly flow operation (1.84 mL/s), and g.-i. ‘no mess’ plant removal (clip refs. 111, 122, 129, 131).

Figure 3.10  a. Effectively constant channel volumes during long duration stable parallel flow in Wedge channel (1.37 mL/s, clip ref. 220). b. Transient upper and lower Wedge channel volume shifts during parallel flow instability tests. Average volume is shown in gray. Manual efforts to balance the system are noted above the figure (Ref. Figure 3 for valve color assignments, clip refs. 21-28). The volume tracking data are noisy when crew actions temporarily obscure the camera view of the liquid in the channels.

Figure 3.11  Parallel Wedge channel flows images from runs in 3.10. a. Stable configuration corresponding to Figure 3.10a at $t = 5:00$. b.-c. Channel fill state images from the run shown in Figure 3.10b. Image in b. corresponds to the fluid state at $t = 12:50$, while c. corresponds to the fluid state at $t = 36:30$. 
Figure 3.12  Specific flow instability demonstrations: a. ingestion limit in Wedge channel with nearly root plugged channel (1.11 mL/s, clip ref. 249), b. de-pinning limit in Wedge channel due to inlet bubble coalescence leading to de-pinning (1.82 mL/s, clip ref. 130), and c. bubble coalescence in Cylinder channel inlet leading to break-up and disconnection between inlet and outlet fluid bodies (1.67 mL/s, clip refs. 164-170).

Figure 3.13  Passive bubble separation (black arrows) in Wedge channel after 10 mL gas syringe injections: a. 39 mL fill at 0.9 mL/s (clip ref. 273), b. 25 mL fill at 1.33 mL/s (clip ref. 281), and c. 31.5 mL fill at 2.52 mL/s (clip ref. 289). All flows eventually become bubble free; however, larger bubbles in slower flows tend to become wall-bound, slowing their progress towards merging with the free surface.

Figure 3.14  Upstream fitting with characteristic volumetric separation/diversion efficiency for bubbles tested (in %): a. non-diverting wye (50%), b. bubble diverter I (>98%) and c. bubble diverter II (>99%). Flight images of typical performance in d. and e.
Figure 3.15  

a. Plot of the remaining volume in the passive reservoir during a 36-minute long-duration run. The dashed line is a linear fit with an average drain rate of 23.6 mm$^3$/min. b. Detailed depiction of the meniscus in the passive reservoir during use. Direction of outflow indicated with large arrow. The tube on the left is open to cabin air for pressure relief, while dark object in the fluid on the right is a felt wick connecting to the downstream tubing.
List of Symbols

\( A \)  
cross sectional area

\( \alpha \)  
disk sector angle, wedge half-angle

\( C_i \)  
initial sugar concentration

\( \delta \)  
wedge parameter, defined as \( \pi/2 - \alpha - \theta \)

\( \dot{E}^r \)  
foliage evaporation rate

\( \dot{E}_f \)  
evaporation rate of nutrient fluid

\( \epsilon_A \)  
media area porosity

\( \epsilon_{felt} \)  
felt porosity

\( \epsilon_{soil} \)  
soil porosity

\( \dot{E}_{water} \)  
evaporation rate of water

\( F_i \)  
numerical flow resistance coefficient

\( g_o \)  
acceleration due to Earth’s gravity

\( h(t) \)  
meniscus height

\( H_1 \)  
upstream fluid meniscus height

\( H_2 \)  
downstream fluid meniscus height
$k$ empirical pore constant

$K$ porous media permeability constant

$L$ element length, length scale

$l(t)$ advancing liquid front in the foliage

$\mu$ dynamic viscosity

$\phi$ relative humidity

$P_{R_i}$ pressure at the foliage inlet

$Q$ volumetric flow rate

$\rho$ fluid density differences across the free surface

$R_i$ radius of the foliage inlet

$r_p$ effective pore radius

$R_p$ summation of viscous elements

$\sigma$ fluid surface tension

$\theta$ fluid contact angle

$U$ characteristic velocity

$\langle u_r \rangle$ average radial velocity

$V_{in}$ cumulative volume into the foliage
List of Abbreviations

APH | Advanced Plant Habitat  
CCF | Capillary Channel Flow experiments  
CFE | Capillary Fluid Experiments  
CSELS | Capillary Structures for Exploration Life Sciences  
DSLR | digital single lens reflex  
FDM | fused deposition modeling (3D printing)  
FFT | fast Fourier transform  
FOV | field of view  
GMT | Greenwich mean time  
ISS | International Space Station  
JEM | Japanese Experiment Module  
MWA | maintenance work area  
PSI | Physical Sciences Informatics database  
Node 2 | ISS module called ‘Harmony ’  
OpNom | operation name
PTFE    polytetrafluoroethylene
PWM    Plant Water Management
STS    Space Transportation System (Space Shuttle)
VEGGIE    Vegetable Production System
Chapter 1

Bioregenerative Life Support Systems

1.1 Concept of Operations

As humans embark on longer-duration spaceflights to the Moon, Mars, and beyond in the coming decades, NASA has identified the production of fresh produce in space as an area of research focus [7]. With an ultimate aim of using plants to supplement physical and chemical technologies for atmosphere and water recycling, NASA has laid out a series of incremental goals towards developing a “bioregenerative life support system.” Research objectives include demonstrating plant adaptations to low-gravity, establishing the safety of plants grown in space, and developing efficient methods of crop production in the space-constrained environment of spacecraft or extraterrestrial settlements [12]. The promise of bioregenerative life support systems is that a long-duration mission could reduce its launch mass requirements by growing its own food. In addition, growing fresh plants avoids the nutrient degradation problems associated with long-term food storage and contributes to the mental well-being of astronauts as they tend to the plants [1, 7].
1.2 Water Management Challenges in Microgravity

One particular challenge presented by the microgravity environment is balancing the moisture and oxygen supply to the roots of the plants. An adequate water supply is essential for plant structure, photosynthesis, and transport of nutrients from the roots to the shoots [21]. Fully saturating the roots, however, is not possible as it starves them of oxygen. When exposed to hypoxic conditions, roots switch to anaerobic methods of energy production which is harmful to growth in the short term and ultimately lethal to the plant if not corrected [8]. In terrestrial environments, the presence of larger particles in the soil, combined with gravity-induced draining of water through the soil, creates voids where roots can access air. In the absence of gravity, moisture management becomes more challenging because no such natural draining occurs. Water movement is instead dictated by capillary forces and the wetting characteristics of the nutrient solution, soil, substrate, and container. The lack of gravity-driven flows can easily lead to under or over-watering plants, as well as producing unexpected bulk water distributions within the growing media in ways that are not readily replicable in ground experiments [18].

1.3 Overview of Plant Growth Systems

Despite these challenges, plants have been grown by astronauts in space since the early 1970’s, beginning with the Soviet Oasis series of experiments on the Salyut space stations [31]. The precursor to most current hardware, however, was the Plant Growth Unit flown aboard the Space Shuttle mission STS-3 in 1982 [19]. The Plant Growth Unit and its immediate successor, the Plant Growth Facility, utilized
a sandwich of porous urethane foam and filter cloth to contain the seeds while in flight [6]. Other techniques developed for plant moisture and nutrient delivery include porous tubing networks maintained at a slight negative pressure [7], and media-based systems that use materials ranging from commercial peat mixes to clay particles [14].

The current plant growth habitats on the ISS consist of the Vegetable Production System (VEGGIE) and the Advanced Plant Habitat (APH). VEGGIE was launched in 2014 and intended to demonstrate crop production with minimal crew intervention [15]. VEGGIE uses a clay soil media and fertilizer packed into “plant pillows,” which contain a porous bottom layer to absorb water from a passive capillary mat [14]. Seeds are glued to a wick which penetrates down into the soil media and can be seen in Figure 1.1a. as the white square on the top of the dark soil pouches. Although initial planning intended for all nutrients to also be delivered via the capillary watering mat, salt and microbial buildup on the mat caused the flight hardware to instead deliver fertilizer via pellets in the soil media itself [16, 24]. To date, all plants grown in VEGGIE have been packed into their respective soil pouches on the ground, and all soil pouches have been discarded after a single use [19].

In contrast to VEGGIE, the APH is intended to be a sensor-rich, data collection-focused plant growth habitat. The chamber includes sensors for atmospheric sampling, fluid level tracking, and integrated overhead imaging [18]. Despite these advances in data collection, the APH still uses a pre-packaged, media-based system for plant growth. Plants are loaded into the APH by inserting a “science carrier” containing porous clay media, seeds and embedded porous tubes for water delivery [11]. While this system has been effective at enhancing plant growth, as evidenced by the
Figure 1.1: a. Packed Nomex and Kevlar “plant pillows” prepared for shipment to the ISS for use in the VEGGIE habitat (image credit: NASA). The seed germination wicks can be seen as the white squares on top of the black pouches, while the cylindrical protrusions are the priming ports. b. Astronaut Shannon Walker harvests kale plants grown in one of the two active VEGGIE habitats aboard ISS (image credit: NASA).

26 peppers harvested in November, 2021 (ref. Figure 1.2), the chamber retains all of the limitations of the pre-packaged media-based system. These limitations include a high disposable mass, potential risk of particle containment failures, and the lack of any method to reuse the soil [19].

If the goal of a viable bioregenerative life support system, or the related “salad machine” concept [12] is ever to be achieved, low-gravity plant growth systems need a generational leap forward in mass reduction, simplification of operation, and reusability. The following chapters of this thesis explore two technology demonstration experiments that investigate different methods for passive moisture control within either a soil media or an open capillary channel. Each experiment demonstrates the use of capillary phenomena such as porous wicking, preferential wetting,
Figure 1.2: Flowering and fruiting pepper plants growing in the Advanced Plant Habitat in November, 2021 (image credit: NASA). Note the mesh fabric covering the growing media in the lower portion of the chamber.

and capillary corner flow to enhance fluid control in a simulated growing environment.
Chapter 2

The Plant Water Management Experiments: Soil

2.1 Introduction

This chapter describes a series of soil-based experiments performed on the ISS where a combination of wetting and non-wetting soils are packed into a simulated plant root zone to create pockets of moisture and air that loosely approximate natural draining on Earth. The design and results of these experiments are highlighted, including ISS crew operations, data collection, and synthetic plant ‘evapo-transpiration rate’ behavior. Experiment performance and data collection are discussed, followed by an approximate mathematical model for assessing PWM-Soil test cell performance at the component level.

2.2 Experiment Hardware and Procedures

A representative image of the PWM-Soil Test Cell and hardware set-up is provided in Figure 2.1. The hardware consists of an Ultem® FDM 3D-printed base plate, 60 mL priming syringe, 125 mL fluid reservoir, an approximately 13 cm long, 4.75 mm (3/16 in) ID Tygon® priming tube, and a Soil Test Cell. The test cells and liquid reservoir are fabricated from Accura 60®. The Soil Test Cell is swappable, and 3
versions were employed on ISS with ‘Fast’, ‘Medium’, and ‘Slow’ control wicks to be described shortly in connection with Figure 2.2.

Figure 2.1: a. Soil Test Cell (scale in cm) and b. PWM-Soil Medium hardware during operations on ISS. The darker arcillite soil is wetted by the grape beverage ersatz liquid and only the base of the foliage is wetted. Reservoir meniscus height location $h(t)$ is identified in b.

With reference to components seen in Figures 2.1 and 2.2, the general procedures for each PWM-Soil experimental run are for the crew member to assemble the hardware on the Maintenance Work Area (the portable workbench area), align work light and HD video camera for the desired FOV, and fill the priming syringe with ersatz plant nutrient solution (water-reconstituted fruit punch or grape drink). The priming syringe is then used to fill the fluid reservoir and prime the tubing to the point the liquid at least contacts the priming wick, felt plug, and wedge soil reservoir.

With the syringe valve closed and all other valves open, passive capillary flow
proceeds to draw liquid from the reservoir through the reservoir valve, tubing, inlet wick, wedge reservoir, 1st soil reservoir, control wick (Fast, Medium, or Slow), 2nd soil reservoir, stem, and into the foliage. Once the foliage is saturated, evaporation into the cabin environment sustains continued draining of the fluid reservoir until either the run period elapses or the reservoir is emptied. Timelapse images of the fluid reservoir drain rate provide a quantitative record of the transient capillary wicking and final evaporation (‘evapo-transpiration’) rates. Further details of the hardware are provided herein before review and summary of the data collected and analysis completed.

2.2.1 Soil Test Cell Design

The Soil Test Cells are designed to demonstrate how soil geometry, size, and wettablility can be exploited in microgravity environments to mimic terrestrial soil conditions and achieve mathematically analyzable passive ‘watering’ for simple plant root zones. The test cells are also constructed such that the progression of the advancing liquid front through the various flow components can be recorded by single video camera view [10]. The continuous wicks shown in Figure 2.2e.-h. provide a simple mathematical model for a root zone that connects all wetting media from the priming wick to the foliage. The root models consist primarily of a perfectly wetting 0.4 cm wide by 0.4 cm thick Rayon felt wick. A short 3 cm control wick section is employed as the variable controlling the liquid delivery rate to the 2nd soil reservoir, stem, and foliage. Rayon felt plugs and arms are also features of the root model that assure the capillary distribution of liquid to the wedge, 1st, and 2nd soil reservoirs.
Figure 2.2: a.-d. Low-g ‘falling water table’ concept - as foliage and roots grow, the soil saturation level drops drawing addition air into the soil with priming feed wick shown in red. e.-h. Simple control wick method chosen for PWM-Soil models to vary root delivery rate for f. Slow, g. Medium, and h. Fast models. Dimensions in cm.

On Earth, as plant foliage and roots grow, the effective water table in the immediate area of the plant falls, drawing oxygenating air into the soil during the process. This process can be recreated in microgravity as well. Rather than vary plant model size as illustrated in Figure 2.2a.-d., the wicking rate is instead throttled by varying the diameter of the control wick section between the 1st and 2nd soil reservoirs. The ‘Fast’ cell employs a continuous length of the 0.4 cm by 0.4 cm Rayon felt, the
‘Medium’ a 0.15 cm diameter bundle of wetting nylon string, and the ‘Slow’ cell a single strand of 0.05 cm diameter wetting nylon string fibers (40 µm OD). These control wicks are selected to target under-, marginal-, and over-saturated foliage for Slow, Medium, and Fast models, respectively, shown in Figure 2.2e.-h.

As detailed in Figure 2.1a., the PWM-Soil test cells employ two different soils: a brown, wetting arcillite clay and a blue non-wetting sand (Magic Sand, 99% Silica, 0.6% acrylic copolymer, 0.4% pigments, manufacturer: Educational Innovations, Inc.). Arcillite is a calcinated clay product commonly used by NASA in combination with fertilizers for growing media. Arcillite is highly wetting to aqueous solutions at both grain and sub-grain pore levels. The sifted, washed, rinsed, and dried 1-2 mm grain arcillite 1st and 2nd soil reservoirs are suspended in the similarly sifted 1-2 mm grain non-wetting sand, connected only by the control wick for Fast, Medium, and Slow test cells. The foliage consists of a 0.4 cm thick, 12 cm-radius, 120° circular sector intended to establish 1-dimensional radial flow. The test cell also employs a moderately compressed, coated hydrophobic Scotch-Brite® pad that forms a non-wetting breathable compression barrier for the soil lay-up. A 3.5 mm PTFE shrink-wrap tube is used as the stem’s exterior to support the foliage during the operations.

2.2.2 Experiment Operations on ISS

Crew operations for the PWM-Soil demonstrations were conducted over three, three-day periods beginning February 8, 2021 (GMT Day 39) and ending February 19, 2021 (GMT Day 50). Each operational period included procedures for hardware setup, system prime, an untended run period, and a hardware teardown. The ex-
periments were initially setup and primed on the MWA in Node 2 with realtime video downlink to the investigator team on the ground. For the system prime, the investigator team actively directed the quantities of fluid to be primed into the system, visually inspected the system and provided approval to move ahead with operation. Once the system prime step was completed, the apparatus was transported to the JEM for undisturbed operation and reduced cabin intrusion where an Nikon D5 DSLR camera using a Nikkor 24-70mm f/2.8G ED lens recorded time-lapse images at 5-minute intervals. Each experiment ran in the JEM for approximately 48 hours to provide the longest duration run possible without exceeding the bio-contamination safety limits set by NASA. While initially intended for 48-hour run times, these times varied slightly based on crew availability and were interrupted only by reservoir refill and/or lighting battery change-outs.

At the conclusion of each run, the hardware was returned to the MWA for photography of the final states, discussion of the observed fluid configurations with the crew, test cell draining, teardown, and stow. The equipment was designed to be rapidly assembled and primed to minimize crew time required. As such, total experiment times (crew time) required for the PWM-Soil operations were 49.5 hr (5.25 hr) for Fast, 43 hr (4 hr) for Medium, and 41.5 hr (4.25 hr) for Slow Soil Test Cells. Total crew time was 13.5 hrs. A detailed breakdown of the crew operations is provided in Table 2.1.
Table 2.1: PWM Soil Operations table. Investigator team participated live during all priming and stow operations. Other activities were completed based on predetermined crew procedures.

<table>
<thead>
<tr>
<th>Date</th>
<th>Day</th>
<th>Experiment</th>
<th>Operation Name</th>
<th>Start</th>
<th>End</th>
<th>Elapsed</th>
<th>Crew</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/8</td>
<td>39</td>
<td>PWM Soil Fast</td>
<td>Hardware SU</td>
<td>11:35</td>
<td>12:35</td>
<td>1:00</td>
<td>Hopkins</td>
</tr>
<tr>
<td>2/8</td>
<td>39</td>
<td>PWM Soil Fast</td>
<td>JEM Prep</td>
<td>13:20</td>
<td>14:05</td>
<td>0:45</td>
<td>Walker</td>
</tr>
<tr>
<td>2/8</td>
<td>39</td>
<td>PWM Soil Fast</td>
<td>System Prime</td>
<td>13:35</td>
<td>15:05</td>
<td>1:30</td>
<td>Hopkins</td>
</tr>
<tr>
<td>2/8</td>
<td>39</td>
<td>PWM Soil Fast</td>
<td>Refill Op</td>
<td>18:40</td>
<td>18:55</td>
<td>0:15</td>
<td>Walker</td>
</tr>
<tr>
<td>2/9</td>
<td>40</td>
<td>PWM Soil Fast</td>
<td>Battery Change</td>
<td>14:55</td>
<td>15:10</td>
<td>0:15</td>
<td>Walker</td>
</tr>
<tr>
<td>2/9</td>
<td>40</td>
<td>PWM Soil Fast</td>
<td>Refill Op 2</td>
<td>15:10</td>
<td>15:40</td>
<td>0:30</td>
<td>Walker</td>
</tr>
<tr>
<td>2/10</td>
<td>41</td>
<td>PWM Soil Fast</td>
<td>Hardware Stow</td>
<td>15:05</td>
<td>16:05</td>
<td>1:00</td>
<td>Hopkins</td>
</tr>
<tr>
<td>2/15</td>
<td>46</td>
<td>PWM Soil Med</td>
<td>MWA Prep</td>
<td>16:30</td>
<td>16:45</td>
<td>0:15</td>
<td>Hopkins</td>
</tr>
<tr>
<td>2/15</td>
<td>46</td>
<td>PWM Soil Med</td>
<td>Hardware SU</td>
<td>16:45</td>
<td>17:45</td>
<td>1:00</td>
<td>Hopkins</td>
</tr>
<tr>
<td>2/15</td>
<td>46</td>
<td>PWM Soil Med</td>
<td>System Prime</td>
<td>17:45</td>
<td>19:15</td>
<td>1:30</td>
<td>Hopkins</td>
</tr>
<tr>
<td>2/15</td>
<td>46</td>
<td>PWM Soil Med</td>
<td>JEM Prep</td>
<td>17:30</td>
<td>17:45</td>
<td>0:15</td>
<td>Glover</td>
</tr>
<tr>
<td>2/16</td>
<td>47</td>
<td>PWM Soil Med</td>
<td>Battery Change</td>
<td>17:05</td>
<td>17:20</td>
<td>0:15</td>
<td>Glover</td>
</tr>
<tr>
<td>2/17</td>
<td>48</td>
<td>PWM Soil Med</td>
<td>Hardware Stow</td>
<td>10:50</td>
<td>11:35</td>
<td>0:45</td>
<td>Noguchi</td>
</tr>
<tr>
<td>2/17</td>
<td>48</td>
<td>PWM Soil Med</td>
<td>MWA Prep</td>
<td>16:30</td>
<td>16:45</td>
<td>0:15</td>
<td>Hopkins</td>
</tr>
<tr>
<td>2/17</td>
<td>48</td>
<td>PWM Soil Med</td>
<td>Hardware SU</td>
<td>16:45</td>
<td>17:45</td>
<td>1:00</td>
<td>Hopkins</td>
</tr>
<tr>
<td>2/17</td>
<td>48</td>
<td>PWM Soil Med</td>
<td>System Prime</td>
<td>17:45</td>
<td>19:15</td>
<td>1:30</td>
<td>Hopkins</td>
</tr>
<tr>
<td>2/17</td>
<td>48</td>
<td>PWM Soil Med</td>
<td>JEM Prep</td>
<td>17:30</td>
<td>17:45</td>
<td>0:15</td>
<td>Walker</td>
</tr>
<tr>
<td>2/18</td>
<td>49</td>
<td>PWM Soil Slow</td>
<td>Battery Change</td>
<td>15:15</td>
<td>15:30</td>
<td>0:15</td>
<td>Glover</td>
</tr>
<tr>
<td>2/19</td>
<td>50</td>
<td>PWM Soil Slow</td>
<td>Hardware Stow</td>
<td>9:00</td>
<td>10:00</td>
<td>1:00</td>
<td>Hopkins</td>
</tr>
</tbody>
</table>

2.3 Summary of Primary Results

From images such as presented in Figures 2.3 and 2.4, soil and foliage saturation times can be approximated for the test cells. The clock begins at fluid injection into the test cell during the priming activity and soil saturation is determined when the arcillite soil visibly darkens (no dry arcillite visible, ref. Figs. 2.1b. and 2.3). Foliage saturation is determined when the entire surface of the foliage felt darkens and first begins to appear glossy. The soil saturation time (foliage saturation time) is found to be 2.65 hr (7.32 hr) for Fast, 1.5 hr (4.33 hr) for Medium and 3.1 hr
(undetermined) for Slow. It is not clear why the Medium run primed faster than the Fast run; however, the most likely hypothesis is that bridging between soil reservoirs was created during launch or system prime, allowing fluid to bypass the control wick and flow directly into the 2nd soil reservoir. Variable prime volumes are discussed later in Section 2.4. Unfortunately, due to the poor foliage angle and lighting conditions during the initial hours of the Slow run, foliage saturation cannot be determined for this run from data collected.

**Figure 2.3:** Cropped images of the PWM-Soil Medium Test Cell during prime and capillary infill showing reservoir bridging. The 2nd Soil Reservoir is wetted at 30 min and nearly saturated by 35 min.

Figure 2.4 illustrates the transient wicking of liquid through the Medium foliage which produced the most ortho-normal view. The images in Figure 2.4 are cropped and color-enhanced to emphasize the wetting of the foliage. Fluid was first introduced into the test cell during the prime operation approximately 50 minutes before the first photo shown in the figure. The first image in Figure 2.4, labeled ‘15’, was taken approximately 15 min after the crew first observed darkening in the felt. The darkened foliage expands radially outward with the first fluid reaching the outer
edge of the foliage by the 35 min mark. The foliage surface continues to darken in subsequent images until a glossy, wet surface is observed approximately 210 min (not shown) after fluid introduction. The flow is evaporation limited beyond this point.

The passive capillary liquid uptake into the Soil test cells is digitized from the interval images taken of the receding meniscus in the fluid reservoir and presented in Figure 2.5 for the Fast, Medium, and Slow runs. The meniscus centerline is manually tracked, accounting for changing scale factors, parallax, contact angle hysteresis, non-axisymmetric meniscus sidling, camera rotation and large disturbances to the field of view. The data are fairly smooth with some evidence of crew-induced disturbances (e.g., see Fast data during second refill activity, vertical displacement of the Slow data at 18 hours, and the break in the Medium data at 14 hours). Note that the Fast run included two Fluid Reservoir refills during operations at 3.6 and 24 hours. Both Medium and Slow test cells are allowed to run without reservoir refills.
which drained the approximately 125 mL reservoir at 25 and 29 hrs, respectively.

**Figure 2.5:** Liquid volume uptake into PWM-Soil test cells as determined by fluid depth in reservoir \( h(t) \). The Fast run included two reservoir refills while Medium and Slow runs were not refilled.

To determine the drain rate of the fluid reservoir, power-law functions are fit to the volume uptake results in Figure 2.5, differentiated, and plotted in Figure 2.6. The Fast and Medium Test Cells perform similarly, the most likely explanation being that, as shown in Figure 2.3, the distorted soil reservoirs 1 and 2 were in capillary contact for the Medium cell, shunting the control wick, and producing similarly low flow resistances for both of these test cells.

Porous materials evaporation experiments performed on ISS as part of the CSELS technology demonstrations found evaporation rates for water of 169.6 ± 6.6
Figure 2.6: Transient flow rates derived from power-law fit functions of data in 2.5. Note that Fast, Medium and Slow test cells were force filled to 25.5, 16.0, and 8.2 mL, respectively.

mL/hr·m² at 22 ± 0.2° C and 42 ± 0.2% relative humidity [27]. For the PWM-Soil foliage area of 305 cm² at 22.5 ± 0.2° C and 43.8 ± 1.6% relative humidity, a steady saturated foliage evaporation rate is estimated at \( \approx 5.1 \text{ mL/hr} \) for pure water, which is added to Figure 2.6 (dashed line). The PWM-Soil foliage evaporation, however, does not achieve a steady value due to the decline in evaporation as a function of increasing concentration of sugar in the foliage. This accumulation is easily observed in Figure 2.7, which presents a still image of the foliage taken at the conclusion of the Fast run. The impact of reduced evaporation from the foliage due to increased
sugar concentration in the beverage can be modelled using the linear relationship

\[
\dot{E}_f \sim \dot{E}_{\text{water}}(1 - aC_i(1 + \frac{V_{in}}{\epsilon_f V_f}))
\]  

(2.1)

where \(\dot{E}_{\text{water}} = 5.1\) mL/hr is the low-g evaporation rate of water, \(C_i\) is the initial volumetric concentration of sugars in the ersatz nutrient solution, \(V_{in}\) is the cumulative volume of the solution flowing into the foliage (integrated from Fig. 2.5), \(\epsilon_f \approx 0.95\) is the foliage porosity, \(V_f \approx 60\) mL is the foliage volume, and \(a\) is a linear fit coefficient. This equation is represented in Figure 2.6 for \(1 \leq a \leq 4.5\) as the pink-shaded region between the dotted lines, illustrating that steady evaporation in the PWM-Soil tests cannot be achieved for the sugary test liquid.

Vertical grey regions in Figure 2.5 and 2.6 denote characteristic time zones required for complete soil and foliage saturation. The horizontal grey bands in Figure 2.6 bracket the results of various pre-flight horizontal terrestrial tests performed for Fast and Medium test cells at \(T \approx 20^\circ\) C and \(\phi \approx 40\%\). No terrestrial Slow test cell experiments were conducted. Note that evaporation rates within the foliage are approximately 50% to 60% less than what might be expected for smooth continuous liquid films.

2.4 Operational Notes and Lessons Learned

As observed in Figure 2.5, the transient uptake rate of the three PWM-Soil test cells is accurately quantified for comparisons with analytical models. This objective was achieved despite anomalies associated with the initial soil configurations, unequal volume injections during prime, and image processing. Each is discussed below.
Figure 2.7: Image of Foliage at the conclusion of PWM-Soil Fast test cell run. The glistening surface reveals dye and sugar gradients due to water evaporation from the Tropical Fruit Punch beverage.

2.4.1 Vibration-Related Soil Configuration Anomalies

Prior to launch, the PWM-Soil test cells underwent simulated 3-axis launch load vibration testing with accelerations of 1 to $10g_o$ at frequencies of 100 to 1000 Hz. Initial, unperturbed soil configurations are shown in Figures 2.1a. and 2.2a. A worst-case post vibe-test configuration is shown in Figure 2.8a for one of the qualification units. The obvious disruption of the soil configuration was undesirable from the soil wicking perspective, but not for the overall system foliage wicking perspective since the root-wick remains intact. Due to cost and schedule considerations, it was decided to minimally address the soil disruption problem by *moderately* increasing the compression in the test cells by further compressing the Scotch-Brite™ pad from above during launch. This solution was a compromise to increase soil stability.
without reducing wicking rates from the compressed root structures and adversely increase experiment time on-orbit. The choice was only partially successful.

**Figure 2.8:** a. ‘Lightly’ compressed engineering sample after terrestrial vibration test and ‘moderately’ compressed soils seen during fluid prime for b. Slow, c. Medium, and d. Fast Soil Test Cells. Wedge and 1st reservoirs are distorted to the point of capillary contact in flight test cells, but 1st and 2nd soil reservoirs remain unconnected for Slow and Fast Test Cells. Capillary connection between 1st and 2nd soil reservoirs identified in c.

Figure 2.8b.-d. shows the soil configuration for the Slow, Medium and Fast test cells, respectively, during the transient capillary infill portion of the flight operations. Though reduced compared to the pre-flight vibration test article, the distortions to the soils in the flight hardware are obvious, and the results demonstrate that for all Soil Test Cells the wedge soil and 1st soil reservoirs distorted to the point of contact, providing a significant parallel wicking path between the two. This optically unappealing situation did not, however, impact the flow results due to the way the test cells were primed as will be described. Distortions of the 2nd soil reservoirs are also observed for each test cell but fortunately did not lead to capillary contact between 1st and 2nd Soil Reservoirs for Fast and Slow Test Cells as shown in Figures 2.8b. and d., respectively. However, as also identified in Figure 2.3, a slight capillary
connection between 1st and 2nd soil reservoirs is observed for the Medium Test Cell as identified again in Figure 2.8c. This inadvertent connection permitted a parallel wicking path to the Medium test cell control Wick, increasing the effective capillary flow rate such that the Medium test cell performed nearly identically to the Fast test cell as demonstrated by Figure 2.5.

2.4.2 Variable Liquid Priming Volumes

After filling the fluid reservoir with ersatz nutrient solution, the final step of the system prime crew activity was to create a continuous fluid connection from the reservoir to the test cell. The crew accomplished this task by closing the reservoir valve and dispensing fluid from the priming syringe until the advancing meniscus reaches the bottom of the test cell. This connection allows for subsequent passive wicking from the reservoir into the test cell. As a result of the distorted soil configurations discussed previously, uncertainty concerning the state of the capillary connectivity in the soil reservoirs prompted the investigator team to request an additional ‘plunge’ of the priming syringe for the first and second experimental runs (Fast and Medium, respectively). This caused the Fast Test Cell to receive 25.5 mL during its prime, Medium to receive 16 mL, while the Slow run received only 8.2 mL, the minimum required to make contact with the bottom of the test cell.

The different prime volumes led to variations in the saturation level of the soil reservoirs at the start of each long-duration run. Additionally, the pressurized priming syringe flow may have also forced fluid from the distorted wedge soil reservoir into the distorted 1st soil reservoir. In hindsight, this action was borne out of a desire to avoid a scenario where the distorted soils caused a hidden break in the
capillary connections between elements of the test cell, resulting in no long-duration flow. However, it is most likely that all soil test cells could have received the same prime volume and performed satisfactorily. The Slow test cell was the last experiment performed and, despite receiving the lowest prime volume, demonstrated the desired continuous wicking from wedge to 1st to 2nd soil reservoirs. Regardless, at moderate to long times the initial prime volume is inconsequential as larger amounts of liquid saturate the foliage and continue to flow during the nearly steady evaporation-rate dominated flow confirmed by the nearly coincidental data for Fast and Medium test cells shown in Figure 2.5.

2.4.3 Image Processing

Due to the extended run times of the experiments, each PWM-Soil test run experienced events that complicated the data collection for the reservoir meniscus position $h(t)$. For example, the work light battery died during the Fast run at the midway point, several hours before the next change out, and both Medium and Slow runs also experienced periods of underexposed photos from poor light placements or inconsistent flash firing. When needed, underexposed images were batch-processed to boost gamma and brightness, overexposing the lighter features in the image but allowing the meniscus to be identified by small variations in color. For all images, the centerline interface was manually tracked using the ImageJ plugin ‘Manual Tracking’ (https://imagej.nih.gov/ij/plugins/track/track.html), which records the pointer position with each mouse click and automatically advances to the next slice in the image stack. The length scale in each image is determined by averaging the known height of the reservoir, measured at the front and back vertical edges. The
zero-volume condition is defined as the intersection of the outlet port and domed base of the reservoir.

In addition to the lighting anomalies described above, physical disturbances to the camera during the runs required ‘re-zeroing’ the reference frame. For each re-zero event, new length scale and zero-volume location point measurements are taken. A lookup function is used to reference the correct measurements. Most camera shifts were minor and make little observed difference in the measured volume in Figure 2.5. However, large camera disturbances during battery changes and reservoir refill activities form most of the visible bumps, deflection, and discontinuities seen in the data. Despite such irregularities, reservoir volume could be determined to ±1% accuracy using a combination of image processing techniques.

Contact angle hysteresis, meniscus sidling, and a pronounced ‘stick-slip’ behavior of the contact line are also observed during the reservoir meniscus tracking. Illustrations of these behaviors are shown in Figures 2.9 and 2.10, which contain timelapse images from the Fast run. The timestamps in the figures correspond to the time axis in Figure 2.5. Due to these behaviors, the receding contact angle is observed to fluctuate from 5° to 40° with an observed average receding contact angle of 21 ± 6°. Assuming this value, the liquid volume contained in the meniscus region of the reservoir is found to be 4.82 ± 0.35 mL. This value is significant when compared to the reservoir volume of approximately 125 mL, but varies little enough between test points to not harm the overall measurement precision. A more complete description of data reduction processes, including the process for re-zeroing and re-scaling the images after camera disturbances is described in Appendix A.
Figure 2.9: Illustration of the ‘stick-slip’ behavior observed in the reservoir ($d = 3.5$ cm) during the Fast run, with run time (hh:mm) superimposed on the images. From left to right, the first two images show the meniscus receding towards the outlet at the bottom of the reservoir while the contact line remains stationary. In the third image, the contact line has slipped downwards, as indicated by the black arrow. In the right-most image the meniscus once again moves downward, as indicated by the white arrow, while the contact line remains stationary, starting the ‘stick-slip’ cycle over again.

Figure 2.10: Meniscus ‘sidling’ behavior observed during the Fast run. As time progresses in the images from left to right, the contact line can be seen to move downwards in an asymmetric fashion, with the right side dropping more quickly than the left. In the right-most image, the contact line returns to a nearly perpendicular orientation.
2.5 System Flow Resistance and Modeling Foliage Flow

2.5.1 Flow Resistances of System Elements

A plumbing network model for the Soil Test Cells is sketched in Figure 2.11a. with representations of the eleven serial viscous elements identified in Figures 2.11b-c. Assuming complete saturation and quasi-steady flow through the network, the resistances of each layer may be assessed and compared to identify the dominant contributors to the overall transport. For quasi-steady, fully-developed laminar flows it may be shown that the pressure drop of each element is governed by

\[ \Delta P \sim \frac{\mu U L}{r_p^2} = \mu Q \cdot \frac{L}{A r_p^2}, \tag{2.2} \]

where characteristic properties are dynamic viscosity \( \mu \), local characteristic velocity \( U \), volumetric flow rate through the network \( Q \), element length \( L \), cross-sectional area \( A \), and effective element pore radius \( r_p \). Because \( \mu \) and \( Q \) are constants for all elements, the scaling \( \Delta P/\mu Q \sim L/A r_p^2 \) can be employed to list the computed viscous resistances for the elements in the three soil test cells in Table 2.2.

The geometric flow resistance values for \( L/A r_p^2 \) listed in Table 2.2 imply that elements #1 and #2 contribute negligibly, but that the wick element #7 contributes 77%, 27%, and 8% of the overall resistance for the Slow, Medium, and Fast PWM Soil Test Cells, respectively. The soil reservoirs (#4, #6, and #8) contribute a total of 5%, 15%, and 19%, respectively. The foliage #11 contributes 11%, 36%, and 46%, respectively. Despite the 4-fold increase in resistance between Medium and Fast elements #7, the overall resistance is only 25% higher for the former (8,263/5,563). The Slow PWM Soil Test Cell provides up to 4-fold higher flow resistance than the
Figure 2.11: a. Annotated schematic of PWM Soil test unit (dimensions in cm) with b. fluid element model and c. simplified mathematical model. $H$ is depth into the page.

Fast Test Cell (26,063/6,563).

The pressure in the liquid at any location along the flow path may be assessed with knowledge of the quasi-steady flow rate $Q$ and the upstream viscous resistances. For example, it may be shown that the pressure $P_{Ri}$ at the base of the foliage Figure 2.11a. may be expressed as

$$P_{Ri} = -Q \cdot \sum_{j=1}^{10} \left( \frac{\mu L}{k_j A^2 \rho} \right) \equiv -QR_\mu = -(\langle u_r \rangle A)|_{R_i} R_\mu,$$  \hspace{1cm} (2.3)

where $R_\mu$ is a summation of the viscous resistances in question and $k_j$ is related to the permeability of the $j$th element. The local average volumetric flowrate at the inlet to the foliage is given by $Q = (\langle u_r \rangle A)|_{R_i}$, where $\langle u_r \rangle$ is the local average velocity. Since $Q$ is a function of time, the inlet pressure boundary condition for the foliage flow $P_{Ri}$ is as well.
Table 2.2: Characteristic viscous resistances for plumbing elements of model sketched in Figure 2.11c. Total $\sum_{j=1}^{11} (L/Ar_p^2)j$ values $\cdot 10^{-3} \text{cm}^{-3}$ are 26,063 (Slow), 8,263 (Med.) and 6,563 (Fast). The porosities of arcillite soil and Rayon felt are $\epsilon_{soil} \approx 0.26 - 0.47$ and $\epsilon_{felt} \approx 0.95$. The active foliage area (faces and sides) is $\approx 305 \text{ cm}^2$.

<table>
<thead>
<tr>
<th>Element #</th>
<th>Title</th>
<th>$L$ (cm)</th>
<th>$A$ (cm$^2$)</th>
<th>$r_p$ (cm)</th>
<th>$L/Ar_p^2$ $(\cdot 10^{-3} \text{cm}^{-3})$</th>
<th>Vol (mL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Reservoir, (liq. Props.)</td>
<td>13</td>
<td>9.62</td>
<td>1.75</td>
<td>$\approx 1$</td>
<td>125</td>
</tr>
<tr>
<td>2</td>
<td>Feed line</td>
<td>10</td>
<td>0.17</td>
<td>0.23</td>
<td>1</td>
<td>1.8</td>
</tr>
<tr>
<td>3</td>
<td>Felt Wick/Tube</td>
<td>2</td>
<td>0.17</td>
<td>0.005</td>
<td>470</td>
<td>-</td>
</tr>
<tr>
<td>4</td>
<td>Wedge Soil Res.</td>
<td>1.5</td>
<td>0.16</td>
<td>0.006</td>
<td>260</td>
<td>6</td>
</tr>
<tr>
<td>5</td>
<td>Rayon Felt Wick</td>
<td>1</td>
<td>0.16</td>
<td>0.005</td>
<td>250</td>
<td>-</td>
</tr>
<tr>
<td>6</td>
<td>Soil Reservoir 1</td>
<td>2</td>
<td>0.16</td>
<td>0.005</td>
<td>500</td>
<td>11</td>
</tr>
<tr>
<td>7 Slow</td>
<td>Nylon String</td>
<td>1</td>
<td>0.002</td>
<td>0.005</td>
<td>20,000</td>
<td>-</td>
</tr>
<tr>
<td>7 Med</td>
<td>Nylon String</td>
<td>1</td>
<td>0.018</td>
<td>0.005</td>
<td>2,200</td>
<td>-</td>
</tr>
<tr>
<td>7 Fast</td>
<td>Felt Wick</td>
<td>1</td>
<td>0.16</td>
<td>0.005</td>
<td>500</td>
<td>-</td>
</tr>
<tr>
<td>8</td>
<td>Soil Reservoir 2</td>
<td>2</td>
<td>0.16</td>
<td>0.005</td>
<td>500</td>
<td>11</td>
</tr>
<tr>
<td>9</td>
<td>Felt Wick</td>
<td>1</td>
<td>0.16</td>
<td>0.005</td>
<td>250</td>
<td>-</td>
</tr>
<tr>
<td>10</td>
<td>Felt Wick/Stem</td>
<td>2</td>
<td>0.096</td>
<td>0.005</td>
<td>833</td>
<td>-</td>
</tr>
<tr>
<td>11</td>
<td>Felt Foliage</td>
<td>12</td>
<td>0.16</td>
<td>0.005</td>
<td>3,000</td>
<td>60</td>
</tr>
</tbody>
</table>

*surface tension $\sigma \approx 0.059 \text{ N/m}$ water in arcillite, with ersatz sugar solution $\mu \approx 0.0013 \text{ kg/ms}$ and density $\rho \approx 1030 \text{ kg/m}^3$.

In practice, the priming procedures of the flight demonstrations led to the rapid forced saturation of elements #1 through #6. Subsequently, the transient infill of the 2nd soil reservoir and the foliage followed as variably throttled by control wick, element #7 for Slow, Medium (less so), and Fast Test Cells qualitatively assessed by resistance values $L/Ar_p^2$ in Table 2.2. To estimate such transients, the foliage was fashioned in the form of thin disc-sector which lends favorably to mathematical analysis. The soil reservoirs may also be modelled by this approach as sketched in Figure 2.11c., where soil reservoir disc half-angle $\alpha_{soil}$ and length $L_{soil}$ are varied.
to be representative of the as-built state (ref. Figure 2.11a.) while preserving soil reservoir volume $V_{soil}$ and depth $H_{soil}$. Values for $\alpha_{soil}$ and $L_{soil}$ are selected with $H = 10$ to match $V_{soil} \approx 10$ mL.

2.5.2 Porous Disk-Sector Capillary Flow with Evaporation

Many analyses for wicking flows through porous media with evaporation have been conducted for thermal and transport applications [3, 23, 26]. The geometry used in the PWM Soil experiments is most similar to the evaporating ‘outward penetration’ wicking flow within a thin disc porous media as investigated by Liu et al. (2016) [13]. Liu et al. compute the flow length limits and transients for a horizontal orientation of a thin media while negating the impact of gravity, a requirement of this investigation as well.

![Figure 2.12: Visco-capillary flow model for flow along a stack of disc-sectors: a. Single disc-sector showing advancing meniscus $l(t)$ and b. Stacked lay-up of single disc-sector flows modeling a porous network with evaporation volume loss $\dot{E}''$ through the top and bottom surfaces.](image)

As sketched in Figure 2.12a., the flows are assumed to be radial through the disc sector of half-angle $\alpha$ and gap height $2r_p$, where $r_p$ serves as the effective pore radius. The flow enters at $r = R_i$ and the advancing front is located at $r = l(t)$. 
The overall thickness of the porous media ‘disc-section lay-up’ is \( H \) and its length is \( L \). Volume loss rate through evaporation from this lay-up is treated as a constant sink shared equally over all layers (since \( u_z \approx 0 \)). All flows are visco-capillary flows with negligible inertia and gravity. The analysis assumes a quasi-steady flow with time dependence entering through known pressure boundary conditions applied at entrance \( r = R_i \) where \( P = P_{R_i}(t) \) and at the advancing free surface \( r = l(t) \), where the driving capillary pressure is established \( P(l(t)) = -2\sigma \cos \theta / r_p \), and average velocity is \( \langle u_r \rangle|_t \equiv dl/dt \). From these assumptions the sole \( r \)-momentum equation reduces to

\[
\frac{\partial P}{\partial r} = \mu \frac{\partial^2 u_r}{\partial z^2},
\]

(2.4)

where \( P = P(r, t) \) is the local average pressure, \( \mu \) is the liquid dynamic viscosity, \( u_r = u_r(r, z) \) is the radial velocity and \( z \) is the axial coordinate of the disc sector flow. Equation 2.4 is solved to find

\[
\langle u_r \rangle = \frac{1}{2\mu} \frac{\partial P}{\partial r} (r_p^2 - z^2),
\]

(2.5)

which is integrated over the flow area to find the averaged velocity

\[
\langle u_r \rangle = -\frac{r_p^2}{3\mu} \frac{\partial P}{\partial r}.
\]

(2.6)

To account for the highly idealized geometry of the disc-sector pore lay-up model, from this point forward the generalized Darcy’s Law expression

\[
\langle u_r \rangle \equiv -\frac{k r_p^2}{\mu} \frac{\partial P}{\partial r}
\]

(2.7)
is applied, where \( \sim O(1) \) empirically-determined pore constant \( k \equiv K/r_p^2 \) provides equality in Equation 2.6, where \( K \) is the porous media permeability [13]. Theoretical values for \( k \) for simple geometries are well-established (e.g., \( k \) for flow in a circular tube is \( 1/8 \), in a Cartesian or cylindrical disc slot it is \( 1/3 \), and so on). Average velocity \( \langle u_r \rangle \) is applicable throughout the layup of total thickness \( H \).

To incorporate evaporation into the analysis, as shown in Figure 2.12b., and assuming \( \langle u_r \rangle \) is achieved uniformly in all layers of the media, a steady incompressible fluid control volume balance may be written for the media which reduces to

\[
\frac{\partial (r \langle u_r \rangle)}{\partial r} = -\frac{2 \dot{E}^m r}{\epsilon_A H},
\]

(2.8)

where \( \dot{E}^m \) is the assumed constant volumetric evaporation rate per unit surface area \( (m^3/s \cdot m^2) \), which accounts for surface porosity effects. Both sides of the media are exposed to the air and \( \epsilon_A \) is the media area porosity. Evaporation from the thin sides of the foliage is ignored, based on the assumption that \( H/\alpha L \ll 1 \). The volume loss by evaporation is also assumed to be shared uniformly by each disc sector of the model, not just the top and bottom layers.

Integrating Equation 2.8 yields

\[
\langle u_r \rangle = \frac{C_1}{r} - \frac{\dot{E}^m r}{\epsilon_A H}
\]

(2.9)

and equating Equations 2.7 and 2.9 establishes

\[
\frac{\partial P}{\partial r} = -\frac{\mu}{k r_p^2} \left( \frac{C_1}{r} - \frac{\dot{E}^m r}{\epsilon_A H} \right).
\]

(2.10)
By integrating Equation 2.10, $C_1$ is determined by applying pressure boundary conditions $P(r = R_i) = P_{R_i} \leq 0$ and $P(r = l) = -2 \sigma \cos \theta / r_p < P_{R_i} \leq 0$ such that

$$C_1 = \frac{1}{\ln(l/R_i)} \left[ \frac{kr_p^2}{\mu} \left( P_{R_i} + \frac{2 \sigma \cos \theta}{r_p} \right) + \frac{\dot{E}^m}{\epsilon_A H} \right], \quad (2.11)$$

with surface tension $\sigma$, contact angle $\theta$, and $P_{R_i}$ defined in Equation 2.3. Defining $P_c \equiv 2 \sigma \cos \theta / r_p$, substitution of 2.11 into 2.9 results in

$$\langle u_r \rangle = \frac{1}{r \ln(l^2/R_i^2)} \frac{kr_p^2 P_c}{\mu} \left[ 2 (1 - b \langle u_r \rangle |_{R_i}) + Ca_{ER_i} \left( \frac{l^2}{R_i^2} - 1 - \frac{r^2}{R_i^2} \ln(l^2/R_i^2) \right) \right], \quad (2.12)$$

where $l = l(t)$. The dimensionless group

$$Ca_{ER_i} \equiv \frac{\dot{E}^m \mu R_i^2}{k r_p^2 \Delta P \epsilon_A H} \quad (2.13)$$

appears in 2.12 as a dimensionless evaporation-capillary number, and $b \equiv R_\mu A_{R_i}/P_c$ (units s/m) is a viscous-to-capillary pressure coefficient. For example, in the foliage problem, the inlet pressure $P_{R_i}$ due to upstream viscous resistance is in turn dependent on local inlet velocity from Equation 2.3. The general solution to 2.12 requires first setting $r$ to $R_i$ to find $\langle u_r \rangle |_{R_i}$ and substituting the result back into 2.12 to obtain a single equation for $\langle u_r \rangle = fn(r, l(t))$, which may be solved at $r = l$ to determine $l(t)$. This can then be substituted back to determine $\langle u_r \rangle = fn(r, l(t))$, from which the flow is fully described for average velocities at any location. Equation 2.12 compares closely to Equation 5 in Liu et al. with discrepancies in porosity $\epsilon_A$, double-sided disc-sector evaporation, $P_{R_i} = fn(t) \neq 0$, and the solution is expressed in terms of $r$ and $l$. 
Additional flow model development, including exploration of the velocity condition at the foliage inlet, the maximum disk-sector length that may be wetted before evaporation prevents further advance, and dimensionless equations describing the advancing front during transient infill periods are described in an upcoming paper, Wasserman et al. (2022), which has been submitted to the International Conference on Environmental Systems (ICES).

2.6 Conclusion

The PWM-Soil experiments on ISS demonstrated successful prime and passive liquid nutrient solution delivery to three synthetic plant root-stem-foliage models within a heterogeneous soil network. Evaporative losses simulating evapo-transpiration from the saturated foliage were passively replenished by a ‘no-moving-parts’ capillary driven liquid from a reservoir which was easily refilled by the crew or allowed to drain dry, depending on the run. Six 24-7 days of image data were collected documenting the transient and steady-state behavior of the systems. The approach demonstrated the stable isolation of ‘soil reservoirs’ within a shell of non-wetting soil, providing a measure of control for local liquid storage, aeration within the soil, and a dry stem. The central root structures were designed with a 40-fold variation in control wick resistance with expected 10-fold variation in liquid uptake rates to simulate plants of different maturity. Unexpectedly, though at different rates, the foliage of all plant models tested eventually became saturated such that evapo-transpiration rates were similar to within ±18% and limited only by foliage surface area which was constant.

An analytical model of the fluid transport within the foliage, and within each element of the system was also pursued. The development of this model is summa-
rized here for the foliage and the salient flow resistances for each fluid element within the PWM-Soil system. The model, which is more fully developed in an upcoming paper, serves as an analytical underpinning for the design of soil-based system. The accuracy of the developed model is most dependent on the precision of the plant and soil parameters (i.e., geometries, porosities, pore sizes, permeabilities, etc.). Such values may be difficult to ascertain for living plants, or these values may change over time. For example, the changing root permeability of plants as a function of age, stress or active regulation is currently an area of active research on its own [2, 9]. If, however, plant uptake rates can be suitably estimated for plants at various stages of development, a soil network can be designed to produce the needed flow rates. As the plant foliage grows, the evapo-transpiration rate increases, requiring an increased water supply. With the foliage growth is expected to be parallel root growth which will penetrate deeper into the soil, shortening the viscous wicking length and increasing the flow rate that can be delivered (assuming plant roots can penetrate the non-wicking soils). Additionally, it is possible that as plants continue to grow, the saturation level of the soil reservoirs will decrease, providing increased aeration through added root contact with oxygen-rich air, similar to the way in which voids within a terrestrial soil provide for oxygenation on Earth. Despite the successful demonstration of components of a passive capillary plant-growth system, significant unknowns remain, including changing water needs over time and plant root geometry in the absence of gravity.
Chapter 3

The Plant Water Management Experiments: Hydroponics 3 & 4

3.1 Introduction and Theory

As sketched in Figure 3.1, inertial-visco-capillary flows in open wedge channels have received significant research attention due to their routine occurrence in nature and industry [4, 22]. For sufficiently wetting fluids in the absence of significant gravity, as fluid enters the channel at left and is withdrawn at right (see Figure 3.1), the elevation of the surface reduces along its length $L$ and produces an increasingly negative capillary pressure that drives the fluid passively from left to right along the channel. Such flows are observed and exploited in many situations such as wicking flows within porous media and across hemi-porous surfaces. It can be shown that the impact of gravity and other background accelerations $a$ are negligible provided

$$\rho a L H_1 \tan \alpha / \sigma << 1$$

where $\rho$ is the density difference across the free surface, $H_1$ is the characteristic height of the liquid in the wedge, $\alpha$ is the wedge half-angle, and $\sigma$ is the fluid surface tension. This constraint is met on earth when the length scales of the system $H_1$ and $L$ are small.

Adopting the notation of Figure 3.1, the steady volumetric visco-capillary flow
rate along the channel may be written

\[ Q = \frac{\sigma H_1^3 F_A}{\mu 3L} \frac{F_i \sin^2 \alpha}{f} \left(1 - \frac{H_2^3}{H_1^3}\right) \]  

(3.1)

with

\[ F_A = f^2 \left(\frac{\cos \theta \sin \theta}{\sin \alpha} - \delta\right) \]  

(3.2)

and

\[ f = \frac{\sin \alpha}{\cos \theta - \sin \alpha} \]  

(3.3)

where \( F_i \approx 1/7 \) is a numerical flow resistant coefficient, \( \mu \) is the fluid dynamic viscosity, \( H_1 \) and \( H_2 \) are the upstream and downstream meniscus heights respectively, and the dimensionless area and interface curvature functions are \( F_A \) and \( f \), respectively with \( \delta \equiv \pi/2 - \alpha - \theta \) as described in [29]. It is of interest to observe that \( Q \sim H_1^3 \) such that in microgravity environments, where \( H_1 \) readily assumes values 100-fold those on earth, \( Q \) readily assumes values 10^6-fold those on earth. Such large, ‘no-moving-parts’ flows are attractive for a variety of spacecraft applications including passive hydroponic plant watering systems for advanced research and food production in space. Large length scale wedge flows have been studied aboard the ISS as part of the Capillary Flow Experiments (CFE) [30], Capillary Channel Flow (CCF) [5], and Capillary Structures for Exploration Life Support (CSELS) [27] experiments. The PWM experiments advance this work by focusing on two-phase bubbly flows of contaminated liquid in poorly wetting channels with widely varying channel geometries and flows in channels obstructed by simulated plant roots. Additional background information on the goals and design of PWM hydroponics experiments can be found in part in [25] and [20].
Figure 3.1: Open wedge channel capillary flow with a. free ($L$), b. pinned ($L_p$), and partially pinned contact line boundary conditions. Flow is introduced at left, removed are right, capillary driven flow in between driven by cross flow free surface curvature gradient.

This chapter provides an overview of the PWM 3 & 4 Hydroponics hardware, flight operations, data reduction process, archive, and discussion of the salient preliminary results. The PWM 3 & 4 experiment operated on ISS over six approximately 8-hour crew days from March to July, 2021. The central objectives of these experiments are demonstrations of system priming, start-up, stable single and parallel channel flow, impact of single and multiple simple wicking and evapotranspiring plant models of varying size and complexity, response to varying fill levels, flow rates, ease of plant insertion and removal and shut down. Specific tests to identify the limits of stable operation and the passive mitigation, diversion, and separation of aerating bubbles are also discussed in part here. Over 400 individual tests were performed, the majority of which are only summarized. A reduced data archive with hyperlinked clips of the individual test set-points and video events will be made publicly available on the NASA PSI database (https://psi.nasa.gov), while a condensed version of the same is provided here in Appendix D.
3.2 Experimental Overview

The PWM-Hydroponics hardware is designed for safety and simplicity of use. At the beginning of each operation, the hardware is manually un-stowed and assembled on the MWA aboard the ISS. All tests are performed by crew in the open cabin of the ISS, after which the assembly is drained, disassembled and trashed or stowed. The hardware is further designed such that all quantitative measures can be recorded via a single HD video camera (e.g. flow rate, fill levels, interface configurations, bubble distribution and velocity, etc.).

3.2.1 Test Stand and Channel Design

An image of the experimental setup is provided in Figure 3.2. As identified in the figure, the hardware consists of two hydroponic test channels, a tubing harness that permits flow in a single, serial, or parallel configuration, and a peristaltic pump to circulate liquid through the system. The test channels, fluid reservoir, and wye fittings are 3D printed Accura 60® parts and the 3/16” ID Tygon® tubing is connected using Luer Lock fittings. Two 60 mL syringes, labeled ‘upstream’ and ‘downstream’ by their position relative to the pump, are used to prime the system, to adjust liquid levels during operations, and to make up for liquid lost to felt plant uptake. A third 20 mL gas syringe is filled with cabin air and used to inject bubbles into the system during specific tests. The liquid for the tests is a reconstituted tropical fruit punch prepared by the crew prior to the tests. The properties of the sweetened fruit drink are similar to typical plant nutrient solutions with surface tension $\sigma \approx 0.064$ N/m, density $\rho \approx 1010 \text{ kg/m}^3$, dynamic viscosity $\mu = 0.0012 \text{ kg/ms}$, and channel polymer contact angle $\theta \approx 40 \pm 22^\circ$. A variable-speed peristaltic pump provides
flow in the range of 0.8-4.9 mL/s (for 3/16” ID pump head tubing). The pump flow delivery rate is nominally manually adjusted using the dial on the pump, with precise values determined post-flight from the image processing of the video footage via FFT analysis of the pump head rotation rate (applying a 0.857 mL/cycle for the 3/16” ID pump head tubing employed) [28]. All components are mounted to an ULTEM™ 3D printed back and base plate, which is then secured to the MWA with hook-and-loop fasteners.

Figure 3.2: a. Solid model of PWM-Hydroponics hardware with b. image during flight operations (Q = 0-4.9 mL/s, parallel wedge channel flow, 2-each felt tap root models, clip refs. 59-63). The wye fittings are swappable for 3D printed gas/liquid phase separators and the test channels are swappable between Wedge and Cylinder styles. Plant models are readily added and removed. Upstream tubing is out of frame left in b.

The hardware allows for a variety of flow configurations through the channels during operations. By altering the states of the polypropylene pinch valves, forward and reverse flows may be achieved in the following configurations: a single upper or lower channel path, parallel (simultaneous) flow through upper and lower channels, or serial (sequential) flow through the upper channel followed by the lower channel.
Figure 3.3: Open a. Wedge (76 mL) and b. Cylinder (79 mL) channels with sectional views employed by PWM-Hydroponics 3 & 4 on ISS. Approximate volumes to pinning edges provided. Inlets are sized for 1/4 in Luer Lock fittings with 3/16 in ID tubing. All dimensions in mm. Active channel length is 150 mm.

In all examples included in this chapter, the flow direction is left to right with respect to the channels as pictured in Figure 3.2. The passive refill reservoir can also be opened or closed to the flow path, adding make-up liquid to the system when open. The wye fittings identified in Figure 3.2a. are interchangeable with two pairs of bubble phase-separator fittings for demonstrations of passive bubble phase separation just upstream of the channels.

Four copies each of the two different hydroponic channel designs (eight total channels) were tested. Channel perspective and sections with dimensions are provided in Figure 3.3. The Wedge channel type includes a 20° (half-angle, \( \alpha = 10^\circ \)) wedge with a 4.25 mm high cusp along the vertex. To be discussed in greater detail, the channel employs two parallel 90° pinning edges located 44.3 mm from the bottom edge for a maximum fluid volume of \( \approx 76 \text{ mL} \) when filled to this height. The lower inlet for the Wedge channel is aligned with the bottom of the cusp and the upper inlet is 23.6 mm higher.

The Cylinder channel type contains a 22 mm diameter cylindrical section in the
lower portion of the channel, intended to provide additional room for plant roots. At the top of the cylinder, the channel transitions to an $\alpha = 7.5^\circ$ wedge profile that continues for 18 mm before reaching the two parallel 90$^\circ$ pinning edges. When filled to this edge, the volume of the Cylinder channel is $\approx 79$ mL. The lower inlet for the Cylinder channel extends 0.9 mm below the lower edge of the cylindrical section and the upper inlet is centered 1.6 mm below the top edge of the same. Both test cells include a curved lid with three slots for plant stem alignment. The lids are secured with clear tape which serves as a hinge when placing and removing plants, and for clearing the lid of liquid during stability tests.

3.2.2 Simulated Plant Models

The simulated plant kit includes six different plant models based loosely on different root structures of terrestrial plants. Images of these models are provided in Figure 3.4. The Rayon felt models and foliage are 4 mm thick. The 80 µm OD fiber modacrylic synthetic hair weave models are cut to short (750 mm), medium (1100 mm) and long (1500 mm) lengths. The braided yellow nylon string models consist of 4 each 3-strand frayed lengths of 120, 100, 70, and 50 mm. The strands are made of 40 µm nylon fibers. All plant model roots pass through 25 mm long 4 mm ID coated shrink wrap just below the foliage. The shrink wrap acts as a non-wetting stem to support the foliage. A total of 10 different plant configurations were demonstrated with up to three plants per channel. Though far from realistic, the plant models do serve the purposes of the experiment by demonstrating wetting, wicking, and evapotranspiration. The plant models also occlude the hydroponic channels to various degrees as might be expected of living plant roots.
3.2.3 ISS Flight Operations

Flight operations for PWM 3 & 4 were conducted by six crew members in three test series: March 30-31, May 26-27, and July 27-28, 2021. The first experiment series included both Wedge and Cylinder channels, the second series focused only on Wedge channels and the third series examined only Cylinder channels. Due to the possibility of microbial growth, current ISS safety protocols require the trashing of all wetted components after 48 hours of exposure. Additionally, at the time of the first operations, subsequent operational periods were tentatively planned but not yet approved. These factors guided the decisions on the chronological order of tests performed regarding channel and plant model selection.

ISS flight operations are summarized in Table 3.1. Each of the runs included a hardware setup, system prime, and experiment operations, followed by a complete teardown and stow activity. During system prime and experiment operations, the investigator team had direct audio communication with the crew and realtime video
downlink from a Canon Camcorder with 1280x720 pixel resolution at either 30 or 60 fps. The astronaut crew captured still images throughout the demonstrations at their discretion using a Nikon D5 DSLR camera. After each operation, the crew downlinked the locally-recorded video and still images to the ground.

As a note, while all ground-recorded videos were captured at 30 fps, it was not clear if the frame rate discrepancy observed between different in-flight recordings (30 vs 60 fps) was due to camera settings changes or because of post-processing by NASA ground teams. Both frame rates provide equivalent data quality, however clip-to-clip changes in the frame rate needs to be incorporated into sample rate-dependent data processing procedures discussed in subsequent sections.

Table 3.1: Summary of PWM-Hydroponics operations for Wedge (W) and Cylinder (C) channels with a brief description of demonstrations performed. All dates are 2021.

<table>
<thead>
<tr>
<th>GMT Day</th>
<th>Date (m/d)</th>
<th>Channel (W/C)</th>
<th>Select Demonstrations</th>
<th>Crew Time (hh:mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>89</td>
<td>3/30</td>
<td>W</td>
<td>Single/parallel flow rate sweeps, plants Flows with plants, gas bubble injections, flows at multiple fill levels with plants Flows with plants, parallel long-duration runs, serial flow demo, passive fluid reservoir demo Gas bubble injections, parallel long-duration runs, phase separator/bubble diverter demo Flows with plants, parallel long-duration runs, passive fluid reservoir demo Flows with plants, parallel long-duration runs</td>
<td>6:00</td>
</tr>
<tr>
<td>90</td>
<td>3/31</td>
<td>W/C</td>
<td></td>
<td>7:50</td>
</tr>
<tr>
<td>146</td>
<td>5/26</td>
<td>W</td>
<td></td>
<td>9:15*</td>
</tr>
<tr>
<td>147</td>
<td>5/27</td>
<td>W</td>
<td></td>
<td>7:50</td>
</tr>
<tr>
<td>208</td>
<td>7/27</td>
<td>C</td>
<td></td>
<td>8:00</td>
</tr>
<tr>
<td>209</td>
<td>7/28</td>
<td>C</td>
<td></td>
<td>7:50</td>
</tr>
</tbody>
</table>

*Includes setup time during previous afternoon
3.2.4 Data Reduction & Clips Archive

In total, the PWM 3 & 4 experiments produced 39.15 hours of video footage. To support subsequent analyses, the videos have been catalogued in 437 clips of the various demonstrations and test-points. Each clip is annotated with the date, NASA operation name (OpNom), astronaut name, flow configuration, flow rate, plant models used, and a brief qualitative description of the clip contents. A summary table highlighting different flow configurations performed and selected clips demonstrating these flows is shown in Table 3.2, while a condensed view of the full clips archive is presented in Appendix D. Where applicable, subsequent figures in this chapter contain a clip reference number that ties the images to the clip archive to aid in further study.

The choice to demarcate each clip is somewhat subjective; however, actions such as changing the flow rate, changing the flow configuration (i.e., single to parallel flow), and/or changing the type, number, or order of the plant models are typical examples of actions used to split clips. In case alternate clip splitting is desired in the future, each entry in the PWM 3 & 4 clips archive contains hyperlinks to both the clip and the original source file(s). In an effort to make the clips as useful as possible, in cases where onboard audio capturing the configuration and setpoint instructions was not captured (or was captured but the audio is unintelligible), space-to-ground communications are synced and spliced into the video files.

Whenever the pump head is visible in a video clip, the system flow rate is calculated by measuring the pump head rotation rate (Hz) and multiplying by the linear pump calibration value (0.857 mL/cycle for the 3/16” ID pump head tubing set) determined by ground testing for the CSELS experiment [28], since the pump
Table 3.2: Overview of demonstrated operations, flow patterns and bubble diverters. Clips references to PWM 3 & 4 archive for these flows are indicated in the right-most column. The total experiment times (hh:mm) for the Wedge and Cylinder channels are 22:05 and 17:03, respectively.

<table>
<thead>
<tr>
<th>Flow Demonstration</th>
<th>No. of Clips</th>
<th>Total Time (hr:mm)</th>
<th>Selected Clip Ref. Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wedge Channel Prime</td>
<td>10</td>
<td>1:38</td>
<td>2-4, 202-206, 265-266</td>
</tr>
<tr>
<td>Cylinder Channel Prime</td>
<td>4</td>
<td>0:58</td>
<td>142, 170, 384-385</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1-19, 36-54, 63-102,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>111-137, 204-218, 226-259,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>265-289, 304-313,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>316-354, 360-377</td>
</tr>
<tr>
<td>Single Wedge Flows</td>
<td>234</td>
<td>12:34</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>144-198, 387-388, 431-436</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>20-35, 55-62, 103-110,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>217-225, 290-300, 356-359</td>
</tr>
<tr>
<td>Single Cylinder Flows</td>
<td>72</td>
<td>4:43</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>389-391, 399-430</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>221-224</td>
</tr>
<tr>
<td>Parallel Wedge Flows</td>
<td>61</td>
<td>7:07</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>64-67, 87-90, 96-100,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>159-169, 270-289, 306-354</td>
</tr>
<tr>
<td>Parallel Cylinder Flows</td>
<td>30</td>
<td>9:21</td>
<td></td>
</tr>
<tr>
<td>Serial Channel Flow</td>
<td>4</td>
<td>1:32</td>
<td></td>
</tr>
<tr>
<td>Gas Bubble Injections</td>
<td>129</td>
<td>7:04</td>
<td></td>
</tr>
<tr>
<td>Wedge Flows with Plants</td>
<td>151</td>
<td>9:56</td>
<td></td>
</tr>
<tr>
<td>Cylinder Flows with Plants</td>
<td>86</td>
<td>13:01</td>
<td></td>
</tr>
<tr>
<td>Bubble Diverter (Y or Teardrop)</td>
<td>142</td>
<td>8:31</td>
<td></td>
</tr>
<tr>
<td>Passive Reservoir Refill</td>
<td>8</td>
<td>1:13</td>
<td></td>
</tr>
<tr>
<td>System Drains</td>
<td>34</td>
<td>4:52</td>
<td></td>
</tr>
</tbody>
</table>

used was originally launched for the CSELS experiment. For each clip, 10 seconds of representative video is converted to still images. The pump head rotation rate is found by tracking the pixel intensity at a location on the pump head with time, as shown in Figure 3.5. The pixel intensity plot can then be transformed into a rotational frequency by way of an FFT.

Similarly, to find the instantaneous liquid volume within a given channel, still images are extracted from the video clip at a desired sampling rate (expressed in
The resulting image stack is thresholded, and several points (typically 30) are sampled across the top edge of the binary image to create a series of coordinates corresponding to the location of the free surface. These values are combined with the known shape of the Wedge or Cylinder channels to find the fluid cross-sectional area at each location. The array is then integrated numerically using the trapezoidal rule to produce an approximate volume to within ±5% in the worst case, more typically ±3% for most fill levels. The process is iterated for each image extracted from the video clip, thus establishing the channel volume as a function of time. Due to the resolution of the video files (∼0.5 mm/pixel) and significant contact angle hysteresis (∼20° < θ < ∼70°), a flat fluid surface is assumed in the cross-flow direction. The impact of this assumption is accommodated within the estimated uncertainty of the measurement.

More detailed data processing documentation, including detailed step-by-step instructions, can be found in Appendix B. A copy of all scripts used in the FFT flowrate and volume tracking processes are provided in Appendix C.
3.3 Primary Preliminary Results

3.3.1 System Priming

At the beginning of each day of operations, the channels must be primed with fluid using the upstream and downstream syringes. To prime the channel, an iterative approach is used where, using the downstream syringe, fluid is first dispensed from the right-hand side towards the center. Once the fluid reaches the approximate center of the channel, the process is repeated from the left using the upstream syringe until the two advancing fronts meet and merge to form a continuous surface across the channel. From this point, either syringe can be used to add additional liquid until the desired fill level is achieved. Figure 3.6 illustrates the stages of priming for the Wedge (a.-e.) and Cylinder (f.-j.) channels. In the figure, the first three stages of filling show the prime process simultaneously from both sides; however, these images have been composited together for clarity. Chronologically, the right half of each channel is primed first followed by the left half in Figure 3.6a.-c. (and f.-h.), then the two halves merge in d. (i.), with a final fill level adjustment shown in Figure 3.6e. (j.).

Due to contact angle hysteresis and channel geometry, when filling from the lower inlets, the initial liquid introduced into the Wedge channel tends to spread in a fan-like shape both upwards and across the channel. The pinning edge does act as a barrier to prevent continued upward flow; however, the limits of this barrier were not tested here. Instead, a pulsed infill technique, proposed by Kate Rubins during early operations, was found to be a simple and effective way to limit vertical spread, encourage axial fluid advance and reduce reliance on the pinning edge. The
pulsed infill method involves cycling between adding and removing liquid from the channel. As shown in Figure 3.6a, liquid is initially added until the meniscus reaches the pinning edge. Fluid is then withdrawn from the channel in b., which reduces the height of the meniscus without affecting its axial position. When fluid is now added back to the channel, the shape of the meniscus and channel geometry encourages the fluid front to advance across the channel, as seen in Figure 3.6c.

During Cylinder channel priming, the pulsed infill technique was also utilized. The geometry of the Cylinder channel, however, produced differences in the priming behavior. While the transition from cylindrical to wedge cross sections within the channel provides an additional pinning edge that promotes axial advance during priming (ref. Figure 3.3b. for geometry), the shape also provides a rivulet destabilizing geometry that can lead to break-up of portions of liquid during the infill as shown in Figure 3.6f. When the channel prime on the right side began, the initial injection of fluid jetted a short distance before wetting the container, causing the fluid accumulation to be connected to the inlet by only a small rivulet along the bottom edge of the container. Another behavior seen in Figure 3.6i., to be discussed further in connection with Figure 3.8c., is the tendency of the meniscus to form a hemispherical depression as the liquid level drops below the cylinder-wedge transition. This geometry encourages gas bubble accumulation within the cylindrical portion of the channel.

Once initially wetted, both channels could be readily re-primed when draining was required for plant installation during operations. As will be discussed further, a bubble-free prime was not found to be critical because both channels are tolerant of small gas bubbles in the flow. While both channels theoretically provide for passive
bubble separation, the Wedge channel was found to be more robust in this capacity. This feature of the Wedge channel is explored more in Figure 3.13.

**Figure 3.6:** Sequential/iterative images of pulsed priming for Wedge (a.-e., GMT 89, clip ref. 3) and Cylinder (f.-j., GMT 90, clip ref. 142) channels. Black arrow in a. identifies pinning edge, white arrows identify fill/drain location and direction.

### 3.3.2 Stable Single Channel Flows

The low-g free surface stability of capillary flows in open wedge channels is well established in Refs. [5, 27, 29, 30]. The stability of such flows in the presence of plant models as obstacles is not. Figure 3.7a. provides an example of the stability of single Wedge channel flow without plant model(s). The approximately 23-minute demonstration confirms an essentially constant channel volume to within ±1% which is below measurement uncertainty of ±3%, despite a near quadrupling of flow rate during the run. Figure 3.7b. overlays the free surface height of four selected flow rates over a scaled image of the channel from the run presented in a. For the highest flow rate during this run (4.77 mL/s), an approximately 3 mm increase in the height of the contact line is seen in the right third of the channel along with a decrease in meniscus height in the entrance region caused by suction from the fast-moving flow. The contact line is otherwise stable to approximately 1 mm across the flow rate sweep.
Figure 3.7: a. Approximately 23 min single Wedge channel flow for a ramp sweep in flow rate. Volume measurements are constant at 55.6 ± 0.4 mL apart from crew-induced disturbances during the run (indicated by grey boxes). b. Four free surface overlays on a representative (scaled) image of flow in a. demonstrating surface stability through the range of pump flow rates listed.

Figure 3.8 provides a selection of steady, dynamic free surface configurations for demonstrations with a variety of plant root models. Stable conditions are established for up to approximately 15 minutes for single and multiple plants at varying fill levels, with and without bubbles. Maximum flow rates for stable single channel flows are established to be 4.88 mL/s, with minimum flow rates ranging from 0.8-1.2 mL/s. The high rate is limited by the pump speed, while small variations in pump-head tubing tension (i.e., kit-to-kit variations) affect the lowest speed the pump can spin without stalling. Out-of-plane asymmetries in plant alignment lead to local interface deflections and can lead to local de-pinning (ref. Figure 3.8b., c., and e.), but are not generally observed to cause instability or degradation in channel performance. Entrance region recirculation zones, as sketched in Figure 3.8, are readily observed at all flow rates tested and vary in intensity with plant root type, position, and flow rate. The high flow rate ranges produce inertial flows to the point Bernoulli suction is observed to pull down the fluid interface in the
vicinity of the inlet stream.

Despite the plant root obstructions in the Wedge channel tests, stable flows could be established in all situations depending on flow rate (a value > 0.8 mL/s), with the maximum flow rate before reaching the gas ingestion limit varying as a function of fill level and root obstruction fraction. Pinning edges are also observed to serve as effective boundaries preventing upwards fluid migration. When over-filled or over-driven, as in the case of very large roots (e.g., Figure 3.8f.), the channel lid appears to function as a secondary pinning edge. Satellite droplets ejected by bubbles merging with the free surface are also contained by the lid. A non-wetting material coating above the pinning edge would rebound such droplets back to the channel liquid and provide a significantly improved pinning condition.

Figure 3.9 shows the typical operational cycle for a test run with a plant model. In order to insert the plant, the channel is partially drained, and the plant model is inserted, as seen in 3.9a. The channel is then refilled and run at a variety of fluid levels and pump speeds. Figure 3.9c.-f. demonstrate a variety of fill levels and typical bubble injections, accumulation and separation within the channel. At the conclusion of runs with a particular plant model, the channel is drained again, and the plant model is carefully removed, as seen in 3.9g.-i. Of particular note here is that, despite the wetting nature of the roots, nearly all liquid remains attached to the channel as the plant model is removed, reducing the potential for free droplets.
Figure 3.8: Variety of stable free surface configurations in Wedge channel at flow rates 1.64-1.85 mL/s. a. No plants (clip ref. 40), b.-c. nylon root plants (clip refs. 229, 234), d.-f. taproots (clip refs. 40, 65, 46), and g.-i. weave roots (clip refs. 81, 87, 126). Recirculation zones identified. Note local de-pinning in g. and h. where roots contact the wall of the container.

Figure 3.9: Select demonstrations of typical hydroponics activities (Wedge channel): a.-c. channel refill after new plant placement, d.-f. passive bubble separation (white arrow) in inlet region during steady bubbly flow operation (1.84 mL/s), and g.-i. ‘no mess’ plant removal (clip refs. 111, 122, 129, 131).
3.3.3 Parallel Channel Flow

Stable parallel flows in open capillary wedges have been thoroughly demonstrated during previous space experiments with 2, 4, and 16 parallel channels [27]. These past demonstrations indicate that with sufficient fill level, pinning, contact angle hysteresis, and limits on bubbly flow and flow rates, stable flows are achievable. Prior work has also demonstrated that manifold flow resistance is often greater than that of the open channels and can play a significant role in flow balancing [17]. PWM 3 & 4 adds the complications of larger test channels, plant roots as obstructions, elevated flow rates, and a plethora of bubbles and bubble distributions in both channels and manifolds. Balanced flows are demonstrated as shown in Figure 3.10a. for the Wedge channel at 1.37 mL/s, where channel fill levels hold steady to measurement uncertainty during the 9-min test.

Despite some success in achieving stable parallel flow, variations in tubing, manifold, and channel flow resistances can lead to small imbalances that result in a gradual shift of liquid from one channel to another. This phenomenon is illustrated and annotated in Figure 3.10b., where manual adjustments to the system are made to investigate the limits of stable parallel flow. At the beginning of the run, both test cells are filled to approximately the same level and the pump is turned on. As can be seen in the plot, a fluid shift from the lower to upper channel is immediately observed. When the upper channel is nearly full, the pump is turned off and the syringes are used to manually transfer fluid back to the lower channel. The pump is then turned on and, though the instability is slowed, it is not stopped. The instability is reversed when one upper channel inlet is closed and a second outlet is opened. This reduces the upper channel inflow and increases the upper channel out-
flow enough to reverse the instability, shifting liquid from upper to lower channel. Additional valve changes temper the transfer rate, but stable flow is not achieved for the flow rate settings (> 1.3 mL/s) used for this test. The imbalances are easily controlled through valve adjustments, but as this run shows, potentially difficult to maintain for a given channel arrangement above a low flow rate threshold.

Another observation made during parallel flow demonstrations is that instabilities can develop unpredictably from previously stable flows. One notable example (not pictured) is a 9-minute stable parallel flow with the Cylinder channels which is disrupted when a gas bubble in the upper channel becomes dislodged from the outlet where the fitting screws into the channel material (clip ref. 418). The occluding bubble had reduced the outflow of the upper channel, creating a balanced flow between the channels until it became dislodged at higher pump flow rates, causing an immediate shift in fluid out of the upper channel. Thus bubbles, as well as tubing, fittings, manifolds, and component internal geometry can all lead to parallel flow instability.

From previous experiments, for a low enough flow rate, strong contact line pinning edges and significant contact angle hysteresis will eventually stabilize these second order shifting flows — the liquid rises until it pins in a stabilized, though unevenly distributed flow. At least 11 stable parallel flow conditions are established in the the PWM 3 & 4 demonstrations. Additionally, at least 58 unstable parallel flow conditions are established, with instabilities created by the large channels, plant model obstructions and asymmetries, pinch valve variability, partially occluding wall-bound bubbles, manifold asymmetries, elevated flow rates, and a pinning edge design flaw. [As a note here, the pinning edge of both channel designs was
Figure 3.10: a. Effectively constant channel volumes during long duration stable parallel flow in Wedge channel (1.37 mL/s, clip ref. 220). b. Transient upper and lower Wedge channel volume shifts during parallel flow instability tests. Average volume is shown in gray. Manual efforts to balance the system are noted above the figure (Ref. Figure 3 for valve color assignments, clip refs. 21-28). The volume tracking data are noisy when crew actions temporarily obscure the camera view of the liquid in the channels.

Figure 3.11: Parallel Wedge channel flows images from runs in 3.10. a. Stable configuration corresponding to Figure 3.10a at $t = 5:00$. b.-c. Channel fill state images from the run shown in Figure 3.10b. Image in b. corresponds to the fluid state at $t = 12:50$, while c. corresponds to the fluid state at $t = 36:30$. 
intended to frame the entire perimeter of the channel. Unfortunately, an inspection oversight missed that the printed pinning edges only occurred in the direction parallel to the flow direction, and not in the cross-flow direction at the entrances and exits to the channels. As only briefly addressed herein, this fact did not prevent any of the demonstration objectives from being achieved. It did, however, weaken free surface pinning for certain tests including the parallel flow instability tests. Fortunately the crew was able to quickly and cleanly recover from at least 9 de-pinning or overflow events that partially covered the channel lids. In such instances, the crew withdrew excess fluid from the wetted channel, opened the lid, dabbed the lid and pinning edges with a towelette, replaced the lid, and quickly returned to the procedures. Although stable flows could be achieved with the channel designs tested, stability would have been markedly improved had the pinning edge of the channel been continuous.

3.3.4 Serial Channel Flow

A serial Wedge channel flow was only briefly demonstrated using the serial bypass line (ref. Figure 3.2 for location of the bypass line), where the flow proceeded through the upper channel, through the bypass line, and then through the lower channel. Such tests have proven successful for smaller, slower systems such as those described in Viestenz et al. (2018) [27]. However, in the flow rate ranges of PWM 3 & 4 (> 0.8 mL/s), though serial flow could be observed, flow rate conditions could not be established to avoid the rapid shift of liquid from the downstream to the upstream channel, typically resulting in upstream channel overflow within 1 minute of the run start.
3.3.5 Limits of Operation

A variety of instability mechanisms are pursued as a means to identify the practical limits of operation of the low-g hydroponics system. These include, but are not limited to, any combinations of flow instability due to gas ingestion and liquid de-pinning leading to the pinning edge overflowing (the ‘de-pinning limit’). In all cases demonstrated, the liquid remains contained by the channel lid, and complete recovery of the system is possible with simple crew actions. For example, three instabilities are shown in Figure 3.12 highlighting the gas ingestion limit, the de-pinning limit, and the potential ill-effects gas bubble accumulation (affects Cylinder channel only).

As shown in Figure 3.12a., gas ingestion occurs in a single Wedge channel flow when the flow at the outlet exceeds the capillary pumping limit through the roots resulting in a series of gas bubbles ingested into the channel exit. These bubbles travel through the system and are re-injected into channel. Of the myriad bubbles flowing through the channel, one such bubble lodges in the root bundle in the third image of 3.12a., increasing the capillary flow resistance. This causes a rapid reduction in pumping capacity of the channel and an increase in gas ingestions without the pump flow rate changing. This run was manually stopped at this point; however, in other cases the buildup of volume at the channel inlet from the two-phase flow can reduce the flow resistance and allow recovery from gas ingestions. Additionally, over time the Wedge channel gradually expels the gas bubbles through coalescence and separation.

In Figure 3.12b., injected bubbles coalesce with a large bubble pinned at the inlet of the Wedge channel and accumulate along the plant roots. The pinned
bubble grows both by the coalescence of new bubbles flowing into the channel and by bubbles caught in the inertial recirculation zone in the channel inlet region. The combination of the large root mass with the pinned and wall-bound bubbles further reduces the size of the recirculation zone, increasing mergers. The merged bubbles increase the overall system volume until the fluid de-pins from the pinning edge in the third image of 3.12b. Once free from the pinning edge, the bulk fluid rapidly rises (≈5 sec) to fill the interior corner of the bottom of the lid, necessitating a pause in experiments for a partial drain and recovery.

One adverse behavior noted previously and observed in the Cylinder channel
only is a tendency to accumulate gas bubbles in the cylindrical portion of the channel. Figure 3.12c. illustrates how the rounded cross section, when combined with root obstructions, traps bubbles in the lower portion of the channel. These bubbles coalesce and grow until they completely occlude the cylindrical portion of the channel leading to film rupture across the partially wetting solid surface. Immediately after the liquid surface ruptures, the outlet begins to ingest bubbles as a result of the sudden loss of liquid supply. Accumulated liquid in the system does lead to a recovery of a continuous liquid surface in this run; however, the large bubbles continue to circulate through the system, reach the inlet side again, and the bubble-induced surface rupture repeats. Large bubbles in the cylinder are also observed to work their way underneath the root bundle, forcing the roots upward with continued bubble growth. Further increases in coalesced bubble volume can lead to more frequent gas ingestions, and the possibility of subsequent de-pinning and plant root deflections. These phenomena appear only to occur in the Cylinder channel.

3.3.6 Impact of Bubbles & Phase Separation

Any plant watering system for application in space must account for the presence of bubbles whether produced inadvertently by degassing or biochemistry, or purposefully by bubble ingestion or direct injection for liquid aeration. The PWM 3 & 4 experiments created bubbles purposefully by forced ingestion at the channel exits as well as by direct injection using the gas syringe. Bubble distributions and behavior are observed as noted in Figures 3.8, 3.9, 3.12 and 3.13. At least 129 tests were conducted towards this end. In general, single Wedge channel flows are
insensitive to the presence of bubbles. Tiny bubbles simply circulate through the loop, potentially coalescing in the entrance region recirculation zone, while larger bubbles become wall-bound, merge together, rise in the channel, coalesce with the free surface, and leave the flow (e.g., clip refs. 130-134).

The coalescence, migration and merging of bubbles are investigated with a wide variety of single and multi-bubble injections. Up to 20 mL of air can be injected at one time into the circulating liquid using the dedicated gas syringe. Several examples of the behavior and gradual elimination of bubbles resulting from 10 mL injections are shown in Figure 3.13 for the Wedge channel at three different fill levels. Figure 3.13a. and b. demonstrate an initial cluster of small bubbles near the channel inlet, the coalescence over 30 seconds into a few larger bubbles, the migration of these bubbles upwards, and the eventual mergers with the free surface. Figure 3.13c. displays similar bubble eliminations while also highlighting the ability of the system to recover from an odd liquid configuration resulting from a previous large gas bubble merger in the left-hand side of the container.

Because inadvertent bubbles have the potential to completely destabilize capillary flows, and because plants in low-g environments often suffer from hypoxic conditions, over 7 hours of experiment time were dedicated to investigating bubbly flows in both Wedge and Cylinder channels. The drawbacks encountered with the Cylinder design have been discussed previously; however, for the Wedge design, the channel itself was found to be self-clearing in most scenarios. This reduces the requirement for a bubble-free system prime, any need to limit liquid off-gassing, or concern around gases produced by biochemical reactions within the plants.

One method to improve gas separation efficiency is to introduce the bubbles
Passive bubble separation (black arrows) in Wedge channel after 10 mL gas syringe injections: a. 39 mL fill at 0.9 mL/s (clip ref. 273), b. 25 mL fill at 1.33 mL/s (clip ref. 281), and c. 31.5 mL fill at 2.52 mL/s (clip ref. 289). All flows eventually become bubble free; however, larger bubbles in slower flows tend to become wall-bound, slowing their progress towards merging with the free surface.

closer to the channel free surface. This is demonstrated by replacing the upstream wye fittings with ‘bubble diverters’ that serve to divert the majority of bubbles to the upper inlet of the channel where they concentrate, quickly merge, coalesce, and leave through the free surface. To provide the desired control for such tests, trains of known bubble volume and number are created by turning off the pump, injecting the chosen gas volume, toggling the pump, injecting again the chosen volume, and so on until a train of known bubble volume and number is created. The pump setting is then adjusted and pump turned back on. In this way, the bubble diverters separation efficiency as a function of flowrate and bubble size can be accurately quantified. At the time of publication, however, analysis of these data are not yet complete.

Figure 3.13: Passive bubble separation (black arrows) in Wedge channel after 10 mL gas syringe injections: a. 39 mL fill at 0.9 mL/s (clip ref. 273), b. 25 mL fill at 1.33 mL/s (clip ref. 281), and c. 31.5 mL fill at 2.52 mL/s (clip ref. 289). All flows eventually become bubble free; however, larger bubbles in slower flows tend to become wall-bound, slowing their progress towards merging with the free surface.

Figure 3.14b. and c. show images of the two bubble diverter designs tested, while Figure 3.14d. and e. provide representative examples of phase separation per-
formance, where gas volume separation efficiencies are readily > 99%. For highly regulated bubble flows, efficiencies can approach 100%. With bubble diverter performance in hand and with knowledge of the ingestion limit for the channel, the system can be over-driven while maintaining a stable bubble ingestion rate at the channel exit (clip ref. 367). These bubbles aerate the liquid as they pass through the loop, only to be diverted and separated in the entrance region of the channel upstream of the first plant obstruction. Significant increases in sophistication and control over aeration and phase separation is expected for future PWM experiments currently being planned.

**Figure 3.14:** Upstream fitting with characteristic volumetric separation/diversion efficiency for bubbles tested (in %): a. non-diverting wye (50%), b. bubble diverter I (>98%) and c. bubble diverter II (>99%). Flight images of typical performance in d. and e.

### 3.3.7 Passive Liquid Reservoir Refill

Approximately 90 minutes are spent demonstrating the passive infill capabilities of the fluid reservoir with infill rates in the range 0.022-0.025 ± 0.0015 mL/min demonstrated during a 36-minute run shown in Figure 3.15a., which plots the decreasing volume remaining in the reservoir in time. Referring to Figure 3.2 for locations, opening the valves at either end of the reservoir (labeled fluid reservoir valve and
breather valve, respectively) causes the under-pressure of the loop to naturally draw liquid from the reservoir. This pressure is resisted by capillary pressure in the reservoir, until a balance is achieved. A Rayon felt wick within the reservoir helps to maintain capillary connection between the reservoir and loop. Pressure differences between the reservoir and loop can be adjusted via a variable pinch valve at the base of the reservoir. Demonstrations of this passive ‘evapo-transpiration make-up flow’ suggest that the reservoir valve could be adjusted to match desired set-points such as out-flow rate (maintaining evapo-transpiration rate), or outflow pressure (maintaining constant fill level). Fine-tuning the fluid reservoir parameters will become more important as longer duration runs are pursued in future flight experiments.

3.4 Conclusions

The PWM-Hydroponics technology demonstration experiments provide a sizable database from which to assess and develop increasingly practical low-gravity hy-
droponics plant watering systems that operate similarly to terrestrial versions. In low-g environments, the role of gravity is replaced by the combined effects of surface tension, wetting, and channel geometry. In this setting, an open wedge channel geometry can achieve stable flow conditions of up to 5 mL/s, for an approximately 75 mL, 150 mm long channel even with a variety of synthetic plant models obstructing the flow. The overall system is relatively insensitive to the presence of bubbles, a property which may be exploited in the future to manage bubbles purposefully for liquid aeration. Single and parallel channel flow configurations are demonstrated as well as the limits of operation regarding channel size, flow rates, fill levels, and bubble throughput. Stable system operation is expected below these newly established limits. Operating above these limits can lead to runaway bubble ingestion and liquid de-pinning. When excursions occur, these events are contained by the ‘zero-level-of-containment’ channels and the attached lids, allowing for simple often passive recovery. If operating near channel flow limits, bubble ingestion and liquid de-pinning may be readily prevented via straightforward design modifications such as bubble separators and passive fluid re-fill reservoirs as well as simple manual or automatable interventions.

Practical demonstrations of system start-up, steady operation, response to excursions, physical perturbations, plant size and number, plant placement and removal, and system shutdown are all catalogued and hyperlinked in an archive that will be made publicly available on the NASA Physical Science Informatics database and in Appendix D. The archive may be used to acquire specific data as well as to become familiarized with the rare long-duration low-gravity footage of the highly variable behavior of aqueous solutions. The salient lessons learned from PWM 3 & 4 that
will be invaluable to future advanced system design include:

- Open channel visco-inertial-capillary flows are highly stable in single channels for wide range of fill levels.

- Robust pinning edges and high contact angle hysteresis enhances fluid stability.

- Parallel channel flows are stable below a certain flow rate threshold, but can become rapidly unstable at higher flowrates due to flow resistance imbalances in the system.

- System prime, start-up, shut-down, and restarts do not pose significant challenges to the system due to the passive two-phase flow separating nature of the Wedge channel geometry.

- Current design guides are effective at predicting target performance and flow stability to excursions and physical perturbations.
Chapter 4

Conclusions, Recommendations, & Outlook

While the soil experiments described in Chapter 2 successfully demonstrate the use of non-wetting soils and passive watering systems, all future PWM experiments currently being planned are slated to be hydroponics systems. The use of soil media for low-gravity plant growth will always be subject to scalability limitations due to the mass of the soil, challenges with soil reuse, and the potential for hazards created by particle containment failures. The PWM-Soil experiments do advance the state of knowledge surrounding passive watering and soil aeration techniques; however, the outcomes are not sufficiently advanced when compared to current technologies to merit additional experimentation.

Future Plant Water Management experiments, slated for flight operations in 2023, are now in active development. Based on the results presented in Chapter 3, future PWM hydroponics experiments will focus on refinements to the fluidic elements, pursue additional long-duration steady state stability, and explore the possibility of incorporating living plants with real nutrient solution, automation and control systems. One area of clear improvement for future experiments is in the pinning edge and upper surfaces of the hydroponic channels. The lack of pinning edges on the short sides, combined with the wetting surfaces on the inside of the lids,
allowed de-pinning and overflow events to occur much more easily than is possible. With a more robust pinning edge and a super-hydrophobic lid, the channel free surface will be substantially more resistant to disturbances (≈ 4-fold), and the lid will help rebound ejected droplets back into the bulk liquid.

A functional hydroponics system containing real plants will need to operate continuously for weeks or months. Such a system must provide for required flowrates, aeration levels and nutrient concentrations within the solution throughout the growing cycle. Providing for these requirements will require a further increase in sophistication of flow control, gas bubble introduction, and phase separation. The system will also need to survive an increasing quantity of roots obstructing the flow in potentially unpredictable ways. The next step in PWM advancement may still rely on crew intervention to maintain the system stability; however, a successful hydroponics system must ultimately be able to maintain fluid stability, nutrient, and oxygen delivery to the plants automatically. The introduction of a suite of sensors into the system can likely provide for dissolved gas measurements and nutrient levels, but the method of automating liquid level control is less obvious. It is possible a passive infill method such as that demonstrated with the refill reservoir may be sufficient; however, an active system may also prove necessary. Only longer duration testing will be able to demonstrate and answer this question.

Another area for continued development in future hydroponics experiments is the incorporation of living plants. Current plant growth systems contain pre-packaged seeds within the media and require only the addition of water to begin growing. With a hydroponics system, consideration must be paid to how seeds will be introduced into the system, how young seedlings will be secured, and how these supports will
evolve over the plant’s life cycle. In the absence of gravity or soil, it is possible
that root growth will displace the stems of the plants ‘upwards’ (with respect to
the fluid), and experimentation will be required to determine if plants should be
held in place or allowed to rise as they grow. It is possible that firmly holding
plant stems will improve fluid stability by reducing the opportunity for the nutrient
solution to wick up the plant and escape the channels. However, a firm hold may
also increase channel obstructions, reducing the capillary pumping limit within the
channel. These are design considerations that will need to be explored in future
experiments.

Finally, in addition to the analyses and results presented in this thesis, one key
contribution of the work described herein is the creation of the PWM 3 & 4 clips
archive. The experiments performed for PWM-Hydroponics demonstrated many
flows that are hard to replicate on Earth — large-scale capillary behavior, long-
duration runs, passive phase separation, the role of contact angle hysteresis in the
wetting of aqueous solutions, etc. The difficulty of obtaining these flows in terrestrial
experiments make these data particularly valuable to researchers designing fluid
systems for space. The specific tests performed, however, are hard to access as
they exist within nearly 40-hours of raw video files. The clips archive, by splitting
footage into individual runs with hyperlinks and relevant metadata, will allow future
researchers to quickly peruse the dataset and identify phenomena of interest. It is
the author’s sincere hope that both the archive and the underlying data reduction
processes will be useful for future designs of capillary plant growth and life support
systems.
Bibliography


Appendix A

Data Reduction for Soil Operations (PWM 1)

A.1 Image Corrections with Irfanview

There are many possible programs to perform batch image corrections. The process below is outlined for IrfanView because it is free for education usage and inexpensive for commercial use.

To begin, determine the number of similarly exposed images from the timelapse series that can be batch-processed together, then open a representative image from this batch. This single image will be used as a preview image to determine the brightness and gamma corrections that will best increase the brightness in the liquid reservoir. A manual review of the images is required to determine how many batch adjustments will be needed (one batch per change in lighting configuration).
As shown in Figure A.1, once a representative image is open, open the color corrections dialog box under Image > Color Corrections. From here, adjust the brightness and gamma sliders until the meniscus can be discerned. This may take several tries to find suitable adjustment values. Take note of the final values in the boxes to the right of the sliders before closing the dialog box.

Once satisfied with the adjustments made to the single image, close the file (saving not required) and begin a batch edit session by opening File > Batch Conversion/Rename. In the new popup window, navigate to and select all the files to be batch processed, then click the “Add” button to add them as input files. From here, click the “Options” button and drag the quality slider to 100 to avoid losing any image quality when the files are saved. Now click OK to close the dialog box.
**Figure A.2:** Batch edit Options and Advanced dialog boxes. Drag the JPEG quality slider to 100 to maintain original image quality, then enter the desired Brightness, Contrast and/or Gamma changes into the Advanced dialog box shown on the right.

Next click the “Advanced” button (ensure the “used advanced options” box is checked) and input the image correction values noted earlier into the requisite boxes, as shown in Figure A.2. Finally choose an output folder to save the processed images, then click the “Start Batch” button in the bottom left corner.

The image comparison shown in Figure A.3 illustrates the before and after images from the Medium Soil run.
Figure A.3: Lack of sufficient back-lighting during the Medium timelapse run. The raw camera image is shown on the left, while the right image has been enhanced in IrfanView by boosting the gamma and brightness values to allow the meniscus to be distinguished from the background.

A.2 Meniscus Tracking in FIJI/ImageJ

This section uses the terms ImageJ and FIJI interchangeably, however the plugin used is included with the FIJI package of plugins, so FIJI is recommended over basic ImageJ.

A.2.1 FIJI Manual Tracking Plugin

Starting with the color-corrected images (if necessary), open all images to be tracked using the File > Import > Image Sequence command. Navigate to the location of the files, click on an image in the folder and select “Open”. When presented with the options menu, if FIJI estimates opening the image sequence will consume more system RAM than is installed in your computer, check the “use virtual stack” option shown in Figure A.4 to avoid an insufficient memory error. This open will open each slice directly from the drive as it is needed, so working from an SSD is highly recommended to improve virtual stack performance.
Figure A.4: Image Sequence import option shown at left, with import options shown on the right. If FIJI indicates opening the image sequence will require more RAM than is installed in your computer, check the “Use virtual stack” option.

At this point zoom the image to the region of interest (in this case, so the reservoir fills the screen), then open the “Manual Tracking” plugin from the Plugins > Tracking menu. When the plugin dialog box opens, click the “Add track” button, move the mouse pointer to the bottom of the meniscus centered left-right in the reservoir and click the mouse button. For each mouse click, the plugin will record the mouse location coordinates to the Measurements window and automatically advance to the next slice in the stack.
Figure A.5: Manual Tracking plugin user interface. Clicking the “Add track” button begins the tracking process and saves each click as a measurement in the standard measurement window.

During the tracking process, keep a separate log of every frame in which the camera field of view shifts relative to the prior frame. This log will be used to identify the re-zero points.

When manual tracking is complete for the image sequence, save the Measurements results to a file to proceed with the process.
A.2.2 Identify Re-zero Points

Figure A.6: Screenshot of the processing tab containing the ‘zero-point’ images. These are images immediately after a camera disturbance and are used to re-zero and re-scale the images.

Using the log of re-zero points collected during manual tracking, open each image individually in FIJI and collect the following information:

1. Image name
2. Location in the image of the point where the lower outlet of the reservoir meets the dome of the reservoir end (zero-point)
3. Measurement of the height of the reservoir front edge
4. Measurement of the height of the reservoir back edge

Add these items in a new tab in the workbook containing the saved measurements from the manual tracking process, an example of which is shown in Figure A.6. Use these measurements to average the height of the reservoir, then create a field with a millimeters-per-pixel scale factor using the average pixel value found and the known height of 186 mm.

In order to speed up the process of matching each tracked image to its corresponding re-zero point image, create a column for a “zero point” image reference in the main tracking tab of the workbook, demonstrated in Column A of the workbook shown in Figure A.7. The segment of the workbook shown illustrates a period
of camera disturbances so the zero-point image can be seen to change after each camera movement.

Manually populate the zero point column by referring to the notes taken during tracking, filling all intermediate spaces with the correct zero-point reference (i.e., add the zero-point reference at the location where the disturbance occurs, the drag-fill down to the next disturbance).

Figure A.7: Illustration of how to tie each tracked image to its closest re-zero image. Camera disturbances were noted during initial data review, then the requisite re-zero points were added and a series of VLOOKUP functions were used to populate the information.

Finally, use a series of VLOOKUP (or other preferred Excel-look up) functions to automatically pull the zero-point X and Y coordinates and scale factor into the tracking tab. Calculate a Pythagorean distance from the zero-point to the tracked meniscus location and convert from pixel to mm using the scale factor.

A.3 Contact Angle Determination

Contact angle is determined by finding the difference in height between the contact line and the meniscus, $z$, shown in Figure A.8. When the contact line is not flat and parallel, as described in Chapter 2, the center point is used as the contact line measurement for the image.
The contact angle is then found using the equation

$$\frac{z}{R} = \tan\frac{\pi/2 - \theta}{2}$$  \hspace{1cm} (A.1)$$

where $R$ is the radius of the container, and $\theta$ is the liquid contact angle. Rearranging the equation to solve for $\theta$ yields

$$\theta = \frac{\pi}{2} - 2 \cdot \tan^{-1}\left(\frac{z}{R}\right).$$  \hspace{1cm} (A.2)
Appendix B

Data Reduction for PWM-Hydroponics Operations

B.1 Preliminary Video Handling & Clips Archive

Data from space operations is provided in two forms: 75 minute video clips recorded by the onboard camera and clips of varying lengths recorded at the ground receiving stations. Ground clips are divided up by LOS (loss of signal) periods, and these clips range from approximately 15 to 45 minutes. Whenever possible, the onboard recordings are preferred as they provide a higher quality image and do not suffer from LOS periods. The onboard recording cameras contain two flash cards and automatically switch from card A to card B or vice versa assuming the second SD card is empty. This allows clips to be stitched together when they run across an SD card switchover with only a few-frame interruption in the recording. Some crew remembered to swap full cards for empty ones while the camera was recording on the other card, allowing for continuous video recording during longer operations, however this was not always the case. In cases where the local recording ended and a gap occurred before the card was switched, ground-recorded files are used as supplement.

While perhaps not the case for all future missions, in 2021 ISS local recordings are all labeled with a camera ID of “-m45-“ as shown in Figure B.1, which illustrates the naming conventions for files.
Figure B.1: Naming convention for NASA-provided video files. Files containing “m45” are local recordings from space, while all other designations are ground-recordings of the live video feed.

Once all clips have been arranged in chronological order and any gaps in the recording have been filled using ground recordings, i.e. clips with other camera IDs and timestamps corresponding to gaps in the onboard recordings, the next step in the data reduction process is to cut the raw footage into shorter clips corresponding to experimental runs. Each clip contains one experimental run with a given flow configuration, pump speed and plant arrangement. The guideline is when one of these parameters is changed, the run is considered over, and a new clip is created for the next run. The clipping process also allows the setup, stow and resets between runs to be segregated from the experimental runs, allowing easier access to a specific test configuration while preserving preparatory steps separately.

Figure B.2: Example screenshot of the PWM 3 & 4 video clips archive spreadsheet. As long as this spreadsheet is placed into the same parent folder as the folder containing raw videos files and clips, the hyperlinks should work to open the video of interest.

The key component of the clipping process is the clip index spreadsheet, the “Clips Archive”. This spreadsheet contains the clip name, experimental run details,
a link to the clip and its parent video file, and a brief description of the events in the clip. An example snapshot of the index is shown in Figure B.2. This index serves as the entry point into the Plant Water Management 3 & 4 dataset, allowing an investigator to choose whether they are interested in, for example, runs with plant models or runs without plant models. The archive records 39.15 hours of crew time for the PWM 3 & 4 experiment series broken into 436 clips, with an average clip length of just over six minutes.
B.2 Pump-Head Speed Check Procedure (FFT)

In order to move fluid around the Plant Water Management experiment, a commercial off-the-shelf (COTS) peristaltic pump with a rated flowrate of 0-10 mL/s is used. The speed of the pump is controlled with a dial indicator labeled 0 through 10 and a Fast/Slow rocker switch. The pump rotates a lobed head around which a section of silicone tubing is stretched, moving a fixed quantity of fluid per rotation. Because it was discovered the pump speed varied as a function of specific tubing kit variations (differences in tension), it is important to determine the pump speed for each dial setting at the beginning of each day of operations. The pump used for the PWM experiments was originally delivered to the station several years earlier as a part of the earlier Capillary Structures for Exploration Life Support (CSELS) experiment series, so it is possible the variation is speed is related to age or a slight change in the manufacturing process for pump tubing. The primary source of data for the PWM experiments is video footage, so a sticker with black and white quadrants is attached to the pump head to allow for easy determination of its rotational speed.

The flowrate determination process involves three primary steps: 1) breaking the video clip into a stack of still images, 2) creating a plot of pixel brightness value changes across each image in the stack, and 3) running an FFT to find the dominant frequency of the pixel signal. Many program options exist that can accomplish this task, however for this work Avidemux, ImageJ (FIJI) and Matlab are used. Avidemux’s simple graphical editing tools allow for the selection of an appropriate sample within a clip and a single-click export to still frames. The stacks tools within ImageJ, specifically the “Plot Z-axis profile” tool creates a plot of average pixel value for a selected area as a function of image sequence slice, which can then be analyzed in Matlab to find the pump rotational frequency.

The process begins by opening the video file in the Avidemux, as shown in Figure B.3. From here a selection of a suitable number of frames is made by using the “A” and “B” markers to indicate clip in and out points. From here the clip can be saved as individual images by selecting the “Save Selection as JPEG” option under the File > Save as Image menu options. The precise number of frames needed is subject to the Nyquist limits, however here frequency is quite low and the computing power required to process is not great, so a clip length of 10 seconds is used here. This results in either 300 or 600 frames, depending on the frame rate of the video.
Figure B.3: Avidemux program interface showing a 10 sec clip selected from a longer steady run. The pump head can be seen in the lower portion of the video marked with a black and white sticker.

Once the pump speed clip has been exported from Avidemux as a set of still images, ImageJ is used next to convert the images into a brightness plot. The process begins by opening the series of still images in FIJI as an “image sequence” using the File>Import>Image Sequence command and following the prompts. Once FIJI has loaded the image sequence, a small region of the pump head can be selected using the rectangular selection tool shown in Figure B.4. The precise size of the selection isn’t critical, the default FIJI behavior is the extract the mean pixel brightness of the selection, however a size of 4 pixels was used for consistency and to avoid any issues with potentially stuck pixels in the video clips.
Figure B.4: Illustration of how the pump head selection looks in FIJI. Here the rectangular selection tool is used to select a small pixel grid (4 pixels) to analyze using the plot z-axis profile tool.

After selecting the small pump head region, plot a pixel brightness profile as a function of image slice number by using the “Plot Z-axis Profile” tool under the Image>Stacks menu. This command will create a plot of the mean pixel value of the selected area, ranging from 0-255. This plot can then be saved as a .csv file for import into Matlab.
Figure B.5: Example plot pixel value profile showing the periodic light and dark swings as the pump head rotates. The brightness is an 8-bit value, so its value can vary from 0-255.

Table B.1: Table from the CSELS pump characterization report listing volume pumped per rotation. The tubing size used in all PWM experiments was 3/16.

<table>
<thead>
<tr>
<th>Tube ID (inch)</th>
<th>1/16</th>
<th>3/32</th>
<th>3/16</th>
<th>1/4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume per rotation (mL/rot)</td>
<td>0.100</td>
<td>0.254</td>
<td>0.857</td>
<td>1.43</td>
</tr>
</tbody>
</table>

The final steps in finding pump-head speed is to import the plot profile .csv file into Matlab and use a conventional FFT script to extract the dominant frequency from the brightness plot. The script referenced in C.2 is sourced from online Matlab help documentation for creating an FFT. This produces a standard frequency response plot that can be converted into a flow rate using the CSELS pump volume per rotation table, repeated here as Table B.1, from the CSELS pump characterization report [28]. One important note is that the true rotational frequency is 1/2 that found by the FFT as the pump head sticker contains two light and dark regions per revolution.
B.3 Automated Volume Tracking Process

B.3.1 Cut Video File Into a Clip of Suitable Length

This can be done using any program you desire. One open source recommendation is the program Avidemux, which has been described earlier. This simple editor allows for quick cuts without re-encoding the video (preserves original quality). Avidemux only supports exporting every frame, so the following explains the process using ffmpeg to export periodic frames.

B.3.2 Sample Still Frames from the Video Clip using ffmpeg

The recommended program for extracting still frames is ffmpeg for its power and functionality, however one major downside is ffmpeg is entirely command-line based. To avoid the inconvenience of command-line file handling, the easiest way to use the ffmpeg commands is to copy the video clip into the same folder where ffmpeg.exe is located. Now, start a command prompt window (Run > cmd) and navigate to the folder using the `cd` command followed by the full location of the folder. Copy and paste functions work in command prompt, so it’s typically easiest to copy the folder location from an explorer window into the command prompt. Hit Enter to change directories.

![Command Prompt](image)

**Figure B.6:** Illustration of using command line `cd` navigation to change directories to the working folder.

Now run the following ffmpeg command, altering the `videoclip.mp4` and `fps=5` values to match the clip name and desired sampling frequency, here expressed in frames per second (fps). If less than 1 fps is desired, fractional values present no issue:

```
ffmpeg -i videoclip.mp4 -vf fps=5 image-%05d.png
```
This command tells ffmpeg to export a frame from the clip at the prescribed framerate and save as series of images into the same folder. If you need to export more than 100,000 frames, change the number after the % symbol according to your needs. Additional options exist in ffmpeg, however it is typically easier to cut the clip using another tool (such as Avidemux), then process the entire clip in ffmpeg for simplicity and to minimize command line interactions.

The result of this step will be a set of sequentially numbered image files extracted from the video clip. Move these files into a separate folder for further processing.

B.3.3 Crop Image Sequence to Channel Dimensions using FIJI/ImageJ

Begin by opening FIJI, then import the images created in the previous step by choosing File > Import > Image Sequence and navigating to the folder. Once the image sequence has loaded, use the Rotate tool to straighten the images if required. Ensure the option is checked to have FIJI rotate all images in the stack simultaneously.

To simplify the scripting process, the automated volume tracking script used next assumes the dimensions of the images it processes are the complete active dimensions of the channel. Figure B.8 shows the correct crop size to ensure the script processes properly. The images need to be cropped to the width of the fluid (150 mm) and from the bottom of the fluid to the top of the container where the lid meet the open top. To crop an image in FIJI, simply select the rectangle tool, then drag to the desired crop and choose “Crop” under the Image menu. Alternately, the Duplicate command can be used here to create a new stack with only the cropped images.
Figure B.8: Illustration of the channel cropping process to prepare the image stack for automatic volume tracking.

Once the images have been cropped, save the image stack into a new folder. Choose File > Save As > Image Sequence then fill the options. It is recommended to choose the “use slice labels as file names” option.

Figure B.9: ImageJ Save As menu for saving an image sequence.
B.3.4 Run the Volume Analyzer Macro/Script

The Volume Analyzer macro is a custom script that performs the following functions:

- Reads all the files in a selected folder
- For each file in the folder, the macro:
  - Selects the green color channel (provides best contrast for a red fluid)
  - Converts the image to 8-bit grayscale
  - Runs an automatic threshold function on the image
  - Runs minor cleanup and creates an outlined binary image
  - Splits the image into n slices, where n is the number of points selected
  - Starting at the top for each slice, the program moves down until it finds the first black pixel in the binary image, which corresponds to the fluid surface
  - The program then creates a point here and moves to the next slice and repeats across the image
  - After creating n points, ImageJ saves the points as a .txt file into the folder called “Results Output” and saves an image with the green channel and the thresholded image overlaid in the “Composites Output” folder

Figure B.10 shows an example of how each image is processed. After saving the surface points and a composite of the outline and channel to folders, the Volume Analyzer macro will increment through the rest of the files in the chosen folder.
Figure B.10: Illustration of FIJI windows after the script has created a binary outline (red) and a number of points along the edge indicating the located fluid surface.

To run the macro, go to Plugins > Macros > Run, then choosing the macro file (ImageJ macros end in “.ijm”). When the macro opens, fill out the dialog box shown in Figure B.11, click OK, then navigate to the folder containing the cropped image sequence and select the first file. The first dialog box controls the increment frequency for files. Avidemux only has the option to export every frame, so here you can elect to change the file sampling increment here if needed. Leaving this value at 1 means process every file in the folder, which is the typical choice if a sampling frequency was already chosen in ffmpeg. The second dialog box is the number of points to sample along the fluid surface. For PWM 3 & 4 videos, most views result in approximately 270 pixels width, thus 30 samples corresponds with finding a surface point every 10 pixels. The last user input is the file extension. This exists because the author is somewhat unfamiliar with ImageJ scripting language file-handling operations. There is likely a way to auto-detect the file extension.
Wait while the macro runs. Each file should flash open and closed as ImageJ steps through all the files in the folder. Try to avoid clicking anything in ImageJ as this can interrupt the macro and cause it to stop midway. When the macro has finished, you should receive a message stating how many files were processed.

![Figure B.12: Macro completion message.](image)

**B.3.5 Process Results.txt Files in MATLAB to find the volume**

Open Matlab and open the “PWM Volume Analyzer MATLAB.m” script. Enter the required user-provided parameters at the top of the script, shown in B.13. The critical values to update before each run include the height and width of the cropped channel images in pixels, the sampling frequency in frames per second, and to check that the correct channel shape function is selected (Wedge or Cylinder).
Next run the script. When prompted to select a folder, navigate to the “Results Output” folder created by ImageJ in the prior step. Wait while Matlab processes. The command window provides status updates as files process. Once Matlab is done processing, a plot will appear showing the volume change over time. An example plot is shown in Figure B.14. Matlab will also save an Excel file containing the time and volume results to the working directory.

Figure B.13: User input section of the Matlab volume analyzer script.

Figure B.14: Example Matlab plot output for a channel being manually filled with additional liquid.
Optional Additional Processing Step: Create a Video of Overlay Images

Open a command prompt and change directory to find the folder containing ffmpeg. The command to create a video is shown below. Change the framerate to match the original rate in order to create a move of the same length as the original clip. Input file location and output file location should be changed in the command as well. For the h264 encoding, the resulting frame must be an even number of pixels (required by codec), so additional padding code is added to avoid a “FFMPEG (libx264): height not divisible by 2” error when exporting. For more information on creating a video from still images using ffmpeg, please refer to online help documentation.

```
> "c:\ffmpeg\bin\ffmpeg.exe" -framerate 5 -i
"<folder>\overlay_image-%05d.tif"
"c:\users\marcb\videos\composite_video.mkv"
```

Example with h264/mp4 video output:

```
"c:\ffmpeg\bin\ffmpeg.exe" -framerate 5 -start_number 1
-i "c:\Users\marcb\Pictures\PWM 3_4\PWM34 Image Processing\ImageJ Volume Analysis\Lower_filling_test\cropped_channel2\Results_Output\Plot_Images\plot_frame_%d.tif" -vf
"pad=ceil(iw/2)*2:ceil(ih/2)*2" -vcodec libx264
-pix_fmt yuv420p "c:\users\marcb\videos\plot_video.mp4"
```

Example with uncompressed AVI output:

```
"c:\ffmpeg\bin\ffmpeg.exe" -framerate 5 -start_number 1 -i
"c:\Users\marcb\Pictures\PWM 3_4\PWM34 Image Processing\ImageJ Volume Analysis\Lower_filling_test\cropped_channel2\Composites_Output\overlay_image-%05d.png"
"c:\users\marcb\videos\channel_overlay_video.avi"
```
Appendix C

Data Reduction Scripts

C.1 ImageJ/FIJI Pump Speed Script

```java
// Quick macro to automate image sequence import & saving

// Dialog.create("FFT Image Import Macro");
// Dialog.addDirectory();

run("Input/Output...", "jpeg=85 gif=-1 file=.csv use_file copy_row
  save_column");

parentDir = getDirectory("Choose a Directory");

// parentDir = Dialog.getString();
dirList = getFileList(parentDir);
numFiles = lengthOf(dirList);

// Troubleshooting code only
/*
 * parentDir;
 isit = File.isDirectory(parentDir);
 print(isit);
 print(parentDir+dirList[5]);
 isit2 = File.isDirectory(parentDir+dirList[5]);
 print(isit2);
 */

// Main loop

for (k=0; k<numFiles; k++) {
    path = parentDir+dirList[k];
    print(path);

    if (File.isDirectory(path)) {
        fileList = getFileList(path);
```
print("Found a folder! Opening it");
run("Image Sequence...", "open="+path+fileList[0]+" sort");

Dialog.createNonBlocking("User Input Needed");
Dialog.addMessage("Select a small portion of the pump head, then click OK");
Dialog.setLocation(1000,0)
Dialog.show()
//maybe try "wait for user" next time

run("Plot Z-axis Profile");
Plot.getValues(xpoints, ypoints);

for (i = 0; i < xpoints.length; i++) {
    setResult("x", i, xpoints[i]);
    setResult("y", i, ypoints[i]);
}
updateResults();

suffixindex = indexOf(fileList[0], ".");
subname = substring(fileList[0], 0, suffixindex);

saveAs("Measurements", parentDir+subname+".csv");
print("File saved as: "+parentDir+subname+".csv");
wait(1000);

run("Clear Results");
close();
run("Close");

Listing C.1: Workload reduction script to process FFT images of all video clips in ImageJ. Once you have created folders full of still images of the pump consolidated into a central processing folder, this macro will open each subfolder as an image sequence, pause to allow the user to select a point on the pump head, then plot the pixel intensity, save the result to a file, close the image sequence and open the next.
C.2 Matlab FFT Script

```matlab
Script to batch-process FFT profile plots from ImageJ
Marc Wasserman, 2−13−2022

User notes:
− Only setup to do 10−second video clips (autodetect hz is a frame count), otherwise needs a manual framerate input
− File import format = .csv
− Expects slice n in column 1 and pixel value in column 2
− Need to put all the csv’s into a single folder, the select this folder when prompted
− Kind of crappy 0hz rejection: basically just throw out first FFT point

selpath = uigetdir;
fileList = dir(selpath+"/*.csv");
numFiles = length(fileList);
for k = 1:numFiles
    clear vars for next loop, avoid weird problems
    clear A Fs T L t Y P2 P1 f max_num max_idx;
    fprintf('Processing File number %d \n', k);
    %FFT help script, basically copied line−for−line from Matlab help
    [%d,s] = xlsread(selpath+"/"+fileList(k).name);
    A = readmatrix(selpath+"/"+fileList(k).name);
    Fs = 30; % Sampling frequency (fixed), could toggle
    if size(A,1) > 400 %Figure out roughly if 30 or 60hz based on number of frames in 10sec clip
        Fs = 60;
    else Fs = 30;
    end

    T = 1/Fs; % Sampling period
    L = size(A,1); % Length of signal
    t = (0:L−1)*T; % Time vector
```
\[ Y = \text{fft}(A(:,2)); \]  
\% Output from ImageJ has data in column 2 (col 1 is slice n)
\[ P2 = \text{abs}(Y/L); \]  
\% 2-sided spectrum P2
\[ P1 = P2(1:L/2+1); \]  
\% 1-sided P1
\[ P1(2:\text{end}-1) = 2*P1(2:\text{end}-1); \]
\[ f = Fs*(0:(L/2))/L; \]
\[ [\text{max} \_\text{num}, \text{max} \_\text{idx}] = \text{max}(P1(2:\text{length}(P1))); \]
\[ \text{pumpSpeed}(k) = f(\text{max} \_\text{idx}+1); \]
\end

%%I hate Matlab IO... gross brute-forced save results as a csv file:
\text{names} = \{\text{fileList} \_\text{name}\};
\text{resultsTab} = [\text{names}', \text{num2cell(\text{pumpSpeed}')}] ;
\text{writetable(resultsTab, 'Pump\_speed\_outputs.csv')};
\text{fprintf('Processing completed');}

\textbf{Listing C.2:} Matlab Pump Speed FFT Script. This script includes file-handling code to crunch through an arbitrarily large number of pixel intensity plots in the selected folder. This script follows naturally after the ImageJ FFT processing macro as that script creates a folder full of pixel-intensity plots to be processed via FFT into pump frequency results.
C.3 ImageJ Volume Analysis Script

```java
// Plant Water Management: Volume Analyzer
// version 1.2
// 2/14/2022

// User prompts dialog box:
samplef = 1; // process every nth frame
numpts = 30; // number of points within each frame
filetype = ".tif";

Dialog.create("Volume Analyzer");
Dialog.addNumber("Sample every n frames (choose 1 if fps selected in ffmpeg)", samplef);
Dialog.addNumber("Number of sample points within each frame:", numpts);
Dialog.addString("Type of image file (include dot)", filetype);
Dialog.addMessage("Click OK, select the first file of the sequence and click Open.");
Dialog.show();

// Update parameters with user choices:
samplef = Dialog.getNumber();
numpts = Dialog.getNumber();
filetype = Dialog.getString();

// Determine file location and save location/directory as variables:
path = File.openDialog("Select a File: ");
    // open(path); // open the file
dir = File.getParent(path);
// name = File.getName(path);
fileList = getFilesList(dir);
umFiles = lengthOf(fileList);

// Open the first file... temporarily for make directory purposes (hacky)
open(path);

// Create two directories in current location
myDir1 = File.directory+"Composites_Output"+File.separator;
myDir2 = File.directory+"Results_Output"+File.separator;
    File.makeDirectory(myDir1);
    File.makeDirectory(myDir2);
    if (!File.exists(myDir1))
        exit("Unable to create directory");
    if (!File.exists(myDir2))
        exit("Unable to create directory");
```


close("*"); //Close first image

run("Set Measurements...", "invert redirect=None decimal=3"); //Sets 0,0 to bottom left corner, but only apparently in the measurement output

//Start Outer Loop

for(k=0; k<lengthOf(fileList); k+=samplef){
  for(k=0; k<1; k+=samplef){
    name = fileList[k];
    open(name);

    //Prep for image processing: remove name suffix, determine where sample points go, etc.
    suffixindex = indexOf(name, filetype);
    subname = substring(name, 0, suffixindex);
    width = getWidth;
    height = getHeight;
    p = numpts; //number of points
    n = p+1; //fencepost issue quickfix
    dn = (width/n);

    //Image Thresholding
    //run("8-bit");
    run("Duplicate...", "title="+subname +"-1"+ filetype);
    setRGBWeights(0, 1, 0); //use only green channel because fluid is red
    selectWindow(name);
    run("8-bit"); //convert to greyscale
    selectWindow(subname +"-1"+ filetype);
    run("8-bit");

    setAutoThreshold("Default");
    //setThreshold(0, 162); //threshold values from manual test... failed, lets try auto
    setOption("BlackBackground", false);
    run("Convert to Mask");
    run("Fill Holes");
    run("Outline");

    //Inner Loop (processes each file and creates a .txt file with the results)
    for (i = 1; i < n; i++){
      a = floor(i*dn); //works like round-down
\begin{verbatim}

b = 5;  // Start 5 pixels down from top, avoids bad thresholding at
top edge of channel
while (getPixel(a, b) == 0 && b < height) {
    b += 1;
}
makePoint(a, b);
roiManager("add");
}

roiManager("measure");
saveAs("Results", myDir2+subname+".txt");

run("Merge Channels...", "c1=[" + subname + "] -1" + filetype + "] c4
    =[" + name + "] create ignore");
run("Stack to RGB");
saveAs("tiff", myDir1+"overlay_"+subname);

run("Close All");
roiManager("reset");
run("Clear Results");

}

resultList = getFileList(myDir2);
numResults = lengthOf(resultList);
print("Input folder contained "+k+" files. Processed "+numResults+
    "image files. Processing complete.");
\end{verbatim}

Listing C.3: ImageJ Volume Analyzer Script to process a closely-cropped
PWM channel image and convert the image data into a series of x,y-coordinates
along the free surface.
C.4 Matlab Volume Analysis Scripts

```matlab
%PWM Volume Analysis Script
%Used on the Results_Output folder from ImageJ
%
% NOTE: Requires "WedgeArea.m" or "CylinderArea.m" files to run
%
%******!!!!!!! CHECK CYLINDER/ WEDGE FUNCTION
%******!!!!!!! CHECK HEIGHT & WIDTH DIMENSIONS

clear all;

%%%User–Entered Parameters Here:***
ph = 94 ; %image height in pixels
wp = 268 ; %image width in pixels
fps = 1 ; %ffmpeg fps exported
dt = 1/fps ; %time between samples

%BEGIN SCRIPT:
%Select results folder via UI dialog popup
se = uiPath ;
fileList = dir(se +"/*.txt");
L = length(fileList);
mkdir(se , 'Plot_Images');

%Wedge parameters
hm = 53 ; %mm
wm = 150 ; %mm

hconvert = hm/ph ;
wconvert = wm/wp ;

%Outer Loop
for k = 1:L %step through each file in the list
    T = readtable(se +"/"+fileList(k).name);
    %Inner loop code:
    for i = 1:height(T)
        w = T.X(i)*wconvert ;
        s = WedgeArea(T.Y(i)*hconvert) ; %Pass height to WedgeArea function to calculate area
        %Change to CylinderArea() if analyzing the cylinder test cell !!!!
    end

tstep(k) = dt*k – dt ; % time step starting from 0, in seconds
```
vol(k) = trapz(width,sa)/1000; %volume from area function, converted to mL
fprintf('
processing file %i',k) % Output current file number

%Add code to convert & plot all the lines
%plot(T.X*wconvert,T.Y*hconvert);
%hold on;

end

%code to stack plot

%{
hold off;
xlabel('Position along channel (mm)');
ylabel('Height (mm)');
legend('1.24 mL/s', '2.20 mL/s', '3.65 mL/s', '4.77 mL/s');
figure;
%

%Turn this section off to disable plot frame/animation output:
%{
for idx = 1:L
    fig = figure;
    plot(tstep(1:idx),vol(1:idx));
    xlim([0, tstep(end)]);
    ylim([0, 60]);
    frame = getframe(fig);
    img = frame2im(frame);
    imwrite(img, selpath+'/Plot_Images/plot_frame_' + idx + '.tif');
    close(fig);
end
%

plot(tstep,vol);
ylabel('Volume (mL)')
xlabel('Time (s)')

A = [tstep', vol'];
writematrix(A, "Volume_Output.xlsx");

**Listing C.4: Matlab Volume Analyzer Script**
function [wedge_area] = WedgeArea(h)

if h <= 4.85
    wedge_area = 2*(0.0911*h^3 - 0.1244*h^2 + 0.1909*h - 0.0593);
else
    wedge_area = 16.6669 + 2*(2.80*(h-4.85) + 0.5*(h-4.85)^2*tan(10*pi/180));
end
end

Listing C.5: Wedge channel piece-wise function for cross-sectional area. Accepts an input value, height, in mm and outputs the area. Area determined based on measurements of flight hardware CAD images.
\begin{verbatim}
function [cyl_area] = CylinderArea(h)
    \%Piecewise function to compute area of the Plant Water Management
    \%”cylinder” test cell

    R = 11;  \%mm

    if h <= 21.625
        cyl_area = R^2*acos(1-(h/R)) - (R-h)*sqrt(R^2 - (R-h)^2);
    else
        cyl_area = 378.7039 + 2*(2.847*(h-21.625) + 0.5*(h-21.625)^2*tan
                                 (7.5*pi/180));
    end

end
\end{verbatim}

**Listing C.6:** Cylinder channel piece-wise function for cross-sectional area. Accepts an input value, height, in mm and outputs the area. Area determined based on measurements of flight hardware CAD images.
Appendix D

Clips Archive Spreadsheet for Plant Water Management 3 & 4

This section refers to the supplementary file included with this thesis called “PWM34_VideoClips_Index_v02.28.22.csv.” This is a comma-separated-value file with a size of 127 KB. It may be opened in any text editor or a spreadsheet program such as Microsoft Excel. There are no special application requirements to open this file. The file contains a chronological listing of video clips created from the PWM recorded video files. Each clip is annotated with pertinent metadata including the time and date, state of several key variables, and a brief description of the events in the clip. This index can be used to locate particular phenomena of interest quickly for future research efforts.